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About this document

Assumptions

This document assumes that you already have a solid knowledge of the following:

The software tools used for building your application (assembler, linker, C compiler).
The C programming language.

The target processor.

DOS command line.

If you feel that your knowledge of C is not sufficient, we recommend The C Programming Lan-
guage by Kernighan and Richie (ISBN 0--13--1103628), which describes the standard in C pro-
gramming and, in newer editions, also covers the ANSI C standard.

How to use this manual

This manual explains all the functions and macros that the product offers. It assumes you have
a working knowledge of the C language. Knowledge of assembly programming is not required.

Typographic conventions for syntax

This manual uses the following typographic conventions:

Style Used for
Body Body text.
Keywor d Text t.hat you entgr at the commgnd pnjompt or that appears on
the display (that is system functions, file- or pathnames).
Par anet er Parameters in API functions.
Sanpl e Sample code in program examples.

Sanpl e comrent

Comments in program examples.

Reference to chapters, sections, tables and figures or other doc-

Reference

uments.
GUIElement Buttons, dialog boxes, menu names, menu commands.
Emphasis Very important sections.
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Chapter 1

Introduction

This chapter gives a short overview about the different models of the Flasher family and

their features. Additional information can be found in our Wiki. You can find it under the
following URL:

https://wiki.segger.com/Main_Page

Flasher User Guide (UM08022) © 2004-2021 SEGGER Microcontroller GmbH



11 CHAPTER 1 Flasher overview

1.1 Flasher overview

Flasher is a programming tool for microcontrollers with on-chip or external flash memory.
Flasher is designed for programming flash targets with the J-Flash software or stand-alone.
In addition to that Flasher can also be used as a regular J-Link. For more information about
J-Link in general, please refer to the J-Link / J-Trace User Guide which can be downloaded
at http://www.segger.com.

Flasher connects to a PC using the USB/Ethernet/RS232 interface (what host interfaces
are available depends on the Flasher model), running Microsoft Windows 2000, Windows
XP, Windows 2003, Windows Vista, Windows 7, Windows 8 or Windows 10. In stand-alone
mode, Flasher can be driven by the start/stop button, or via the RS232 interface (handshake
control or ASCII interface). Flasher always has a 20-pin connector, which target interfaces
are supported depends on the Flasher model:

Flasher ARM: JTAG and SWD are supported.

Flasher RX: JTAG is supported. Flasher comes with additional 14-pin RX adapter
Flasher PPC: JTAG is supported. Flasher comes with additional 14-pin PPC adapter.
Flasher PRO: JTAG and SWD are supported.

Flasher Compact: JTAG and SWD are supported.

1.1.1 Features of Flasher ARM/PPC/RX/PRO

e Three boot modes: PC-based mode, stand-alone mode, file access mode
Stand-alone JTAG/SWD programmer (Once set up, Flasher can be controlled without
the use of PC program)

e No power supply required, powered through USB
e Supports internal and external flash devices
e 128 MB memory for storage of target program
e Can be used as J-Link (emulator) with a download speed of up to 720 Kbytes/second
e Data files can updated via USB/Ethernet (using the J-Flash software), via FTP, via RS232
or via the file access mode of Flasher
Supported .
Flasher Supported cores target Flash_programmmg speed
model . (depending on target hardware)
interfaces
Flasher between 170 and 300
ARM ARM7/ARM9/Cortex-M JTAG, SWD Kbytes/second
Renesas RX610, RX621, between 30-300 Kbytes/sec-
Flasher RX RX62N, RX62T JTAG ond
Flasher PPC | Power PC €200z0 JTAG up to 138 Kbytes/second
ARM7/ARM9/Cortex-M Rene- ) )
E'Fi‘gher sas RX610, RX621, RX62N, | ITAG, SWD 2‘;2""‘39” 30-300 Kbytes/ sec
RX62T Power PC €200z0

1.1.2 Features of Flasher Compact

e Three boot modes: PC-based mode, stand-alone mode, file access mode

Stand-alone JTAG/SWD programmer (Once set up, Flasher can be controlled without
the use of PC program)

No power supply required, powered through USB

Supports internal and external flash devices

128 MB memory for storage of target program

Can be used as J-Link (emulator) with a download speed of up to 720 Kbytes/second
Data files can updated via USB/Ethernet (using the J-Flash software) or via the file
access mode of Flasher

Flasher User Guide (UM08022) © 2004-2021 SEGGER Microcontroller GmbH
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Supported .
Flasher Supported cores target Flash.programmlng speed
model . (depending on target hardware)
interfaces
Flasher between 170 and 300
ARM ARM7/ARM9/Cortex-M JTAG, SWD Kbytes/second
Renesas RX610, RX621, between 30-300 Kbytes/sec-
Flasher RX RX62N, RX62T JTAG ond
Flasher PPC | Power PC €200z0 JTAG up to 138 Kbytes/second
ARM7/ARM9/Cortex-M Rene- _ _
Flasher sas RX610, RX621, RX62N, ITAG, SWD between 30-300 Kbytes/ sec
Compact ond

RX62T Power PC €200z0

1.1.3 Features of Flasher Portable/Flasher Portable PLUS

e Stand-alone in-circuit-programmer (Once set up, Flasher can be controlled without the
use of a PC program)
e Powered by an internal rechargeable battery (standard batteries for Flasher Portable),
no Laptop or external power supply required.

Note

Multiple firmware images can be stored on Flasher
128 MB memory for storage of target program

Easy selection of image to be programmed, via button
Supported CPUs: ARM Cortex, Legacy ARM7/9, Renesas RX, Freescale PowerPC
Supports internal and external flash
Free software updates*, 1 year of support

Data files can be updated via the file access mode functionality or via J-Flash
Programming speed between 30-300 Kbytes/second (actual speed depends on target
hardware)

Ethernet and RS232 as host interface are not available for Flasher Portable

Note

*As a legitimate owner of a SEGGER Flasher, you can always download the latest
software free of charge. Though not planned and not likely, we reserve the right to
change this policy. Note that older models may not be supported by newer versions
of the software. Typically, we support older models with new software at least 3 years
after end of life

Supported Flash programming speed
SUPPOMIET) GoTEs target interfaces (depending on target hardware)
ARM7/ARM9/Cortex-M JTAG, SWD between 30-300 Kbytes/second
Renesas RX610, RX621,
RX62N, RX62T JTAG between 170 and 300 Kbytes/second
Power PC e200z0 JTAG up to 138 Kbytes/second

1.1.4 Working environment

General

The Flasher can operate from a PC with an appropriate software like J-Flash or in stand-

alone mode.

Flasher User Guide (UM08022)

© 2004-2021 SEGGER Microcontroller GmbH




13

CHAPTER 1 Flasher overview

Host System

IBM PC/AT or compatible CPU: 486 (or better) with at least 128MB of RAM, running Mi-
crosoft Windows 2000, Windows XP, Windows 2003, Windows Vista, Windows 7, Windows
8 or Windows 10. It needs to have a USB, Ethernet or RS232 interface available for com-
munication with Flasher.

Power supply

Flasher Portable: 3x standard AAA batteries or 5V DC, min. 100 mA via USB connector.

Flasher Portable PLUS: internal rechargeable 680mAh Li-Ion battery, min. 100 mA via USB
connector.

Other Flashers: 5V DC, min. 100 mA via USB connector.

Installing Flasher PC-software (J-Flash)

The latest version of the J-Flash software, which is part of the J-Link software and docu-
mentation package, can always be downloaded from our website:
segger.com/jlink-software.htm! For more information about using J-Flash please refer to
UMD8003_JFI ashARM pdf (J-Flash user guide) which is also available for download on our
website.
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14 CHAPTER 1 Specifications

1.2 Specifications

1.2.1 Specifications for Flasher ARM

General

Microsoft Windows 2000
Microsoft Windows XP
Microsoft Windows XP x64
Microsoft Windows 2003
Microsoft Windows 2003 x64
Microsoft Windows Vista
Supported OS Microsoft Windows Vista x64
Microsoft Windows 7
Microsoft Windows 7 x64
Microsoft Windows 8
Microsoft Windows 8 x64
Microsoft Windows 10
Microsoft Windows 10 x64

Operating Temperature +5°C .. +60 °C
Storage Temperature -20 °C ... +60 °C
Relative Humidity (non-condensing) <90% rH
Mechanical

Size (without cables) 121mm x 66mm x 30mm
Weight (without cables) 119¢

Available interfaces
USB Host interface USB 2.0, full speed
Ethernet Host interface 10/100 MBit
RS232 Host interface RS232 9-pin
Target interface JTAG 20-pin (14-pin adapter available)

JTAG Interface, Electrical
USB powered, 100mA for Flasher ARM.

Power Supply 500 mA if target is powered by Flasher
ARM
Target interface voltage (VIF) 1.2 .5V
Target supply voltage Supply voltage is 5V, max.
Target supply current max. 400mA
Reset Type Open drain. Can be pulled low or tristated
Reset low level output voltage (VOL) VOL < 10% of VIF
For the whole target voltage range (1.8V < VIF = 5V)
LOW level input voltage (VIL) VIL < 40% of VIF
HIGH level input voltage (VIH) VIH = 60% of VIF

For 1.8V = VIF = 3.6V

LOW level output voltage (VOL) with a load
of 10 kOhm

HIGH level output voltage (VOH) with a
load of 10 kOhm

VOL = 10% of VIF

VOH = 90% of VIF

For 3.6 = VIF = 5V

LOW level output voltage (VOL) with a load
of 10 kOhm

VOL < 20% of VIF

Flasher User Guide (UM08022) © 2004-2021 SEGGER Microcontroller GmbH
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:—éIa(ilHo::eilglk%ﬁﬁ;Jt voltage (VOH) with a VOH > 80% of VIF
JTAG Interface, Timing

Max. JTAG speed up to 12MHz

Data input rise time (Trdi) Trdi < 20ns

Data input fall time (Tfdi) Tfdi < 20ns

Data output rise time (Trdo) Trdo < 10ns

Data output fall time (Tfdo) Tfdo < 10ns

Clock rise time (Trc) Trc < 10ns

Clock fall time (Tfc) Tfc < 10ns

1.2.1.1 Flasher ARM download speed

The following table lists the Flasher ARM performance values for writing to memory (RAM)

via the JTAG interface:

Hardware

ARM7 memory download

Flasher ARM

720 Kbytes/s (12MHz JTAG)

Note

core etc.

Flasher User Guide (UM08022)
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16 CHAPTER 1 Specifications

1.2.2 Specifications for Flasher RX

General

Microsoft Windows 2000
Microsoft Windows XP
Microsoft Windows XP x64
Microsoft Windows 2003
Microsoft Windows 2003 x64
Supported OS Microsoft Windows Vista
Microsoft Windows Vista x64
Microsoft Windows 7
Microsoft Windows 7 x64
Microsoft Windows 8
Microsoft Windows 8 x64

Operating Temperature +5°C .. +60 °C
Storage Temperature -20 °C ... +60 °C
Relative Humidity (non-condensing) <90% rH
Mechanical

Size (without cables) 121mm x 66mm x 30mm
Weight (without cables) 119g

Available interfaces
USB Host interface USB 2.0, full speed
Ethernet Host interface 10/100 MBit
RS232 Host interface RS232 9-pin

JTAG 20-pin (shipped with 14-pin adapter
for Renesas RX)

JTAG Interface, Electrical

USB powered, 100mA for Flasher RX. 500
mA if target is powered by Flasher RX

Target interface

Power Supply

Target interface voltage (VIF) 1.2 .5V
Supply voltage is 5V, max. (on the J-Link
Target supply voltage RX 14-pin adapter, the target supply volt-
age can be switched between 3.3V and 5V)
Target supply current max. 400mA
Reset Type Open drain. Can be pulled low or tristated
Reset low level output voltage (VOL) VOL =< 10% of VIF
For the whole target voltage range (1.8V < VIF = 5V)
LOW level input voltage (VIL) VIL < 40% of VIF
HIGH level input voltage (VIH) VIH = 60% of VIF

For 1.8V = VIF = 3.6V

LOW level output voltage (VOL) with a load
of 10 kOhm

HIGH level output voltage (VOH) with a
load of 10 kOhm

VOL < 10% of VIF

VOH = 90% of VIF

For 3.6 = VIF = 5V

LOW level output voltage (VOL) with a load
of 10 kOhm

HIGH level output voltage (VOH) with a
load of 10 kOhm

VOL = 20% of VIF

VOH = 80% of VIF
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17 CHAPTER 1 Specifications
JTAG Interface, Timing
Max. JTAG speed up to 12MHz
Data input rise time (Trdi) Trdi < 20ns
Data input fall time (Tfdi) Tfdi < 20ns
Data output rise time (Trdo) Trdo < 10ns
Data output fall time (Tfdo) Tfdo < 10ns
Clock rise time (Trc) Trc < 10ns
Clock fall time (Tfc) Tfc < 10ns

1.2.2.1 Flasher RX download speed

The following table lists the Flasher RX performance values for writing to memory (RAM)

via the JTAG interface:

Hardware

Flasher RX600 series memory download

Flasher RX

720 Kbytes/s (12MHz JTAG)

Note

core etc.

Flasher User Guide (UM08022)
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1.2.3 Specifications for Flasher PPC

General

Microsoft Windows 2000
Microsoft Windows XP
Microsoft Windows XP x64
Microsoft Windows 2003
Microsoft Windows 2003 x64
Supported OS Microsoft Windows Vista
Microsoft Windows Vista x64
Microsoft Windows 7
Microsoft Windows 7 x64
Microsoft Windows 8
Microsoft Windows 8 x64

Operating Temperature +5°C .. +60 °C
Storage Temperature -20 °C ... +60 °C
Relative Humidity (non-condensing) <90% rH
Mechanical

Size (without cables) 121mm x 66mm x 30mm
Weight (without cables) 119g

Available interfaces
USB Host interface USB 2.0, full speed
Ethernet Host interface 10/100 MBit
RS232 Host interface RS232 9-pin

JTAG 20-pin (shipped with 14-pin adapter
for Renesas PPC)

JTAG Interface, Electrical

USB powered, 100mA for Flasher PPC. 500
mA if target is powered by Flasher PPC

Target interface

Power Supply

Target interface voltage (VIF) 1.2 .5V
Target supply voltage Supply voltage is 5V, max.
Target supply current max. 400mA
Reset Type Open drain. Can be pulled low or tristated
Reset low level output voltage (VOL) VOL =< 10% of VIF
For the whole target voltage range (1.8V < VIF = 5V)
LOW level input voltage (VIL) VIL < 40% of VIF
HIGH level input voltage (VIH) VIH = 60% of VIF

For 1.8V = VIF = 3.6V

LOW level output voltage (VOL) with a load
of 10 kOhm

HIGH level output voltage (VOH) with a
load of 10 kOhm

VOL < 10% of VIF

VOH = 90% of VIF

For 3.6 = VIF = 5V

LOW level output voltage (VOL) with a load
of 10 kOhm

HIGH level output voltage (VOH) with a
load of 10 kOhm

VOL = 20% of VIF

VOH = 80% of VIF

JTAG Interface, Timing
Max. JTAG speed up to 12MHz
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Data input rise time (Trdi) Trdi < 20ns
Data input fall time (Tfdi) Tfdi < 20ns
Data output rise time (Trdo) Trdo < 10ns
Data output fall time (Tfdo) Tfdo < 10ns
Clock rise time (Trc) Trc < 10ns
Clock fall time (Tfc) Tfc < 10ns

1.2.3.1 Flasher RX download speed

The following table lists the Flasher PPC performance values for writing to memory (RAM)

via the JTAG interface:

Hardware

Memory download

Flasher PPC 530 Kbytes/s (8 MHz JTAG)

Note

core etc.

Flasher User Guide (UM08022)
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1.2.4 Specifications for Flasher PRO

General

Microsoft Windows 2000
Microsoft Windows XP
Microsoft Windows XP x64
Microsoft Windows 2003
Microsoft Windows 2003 x64
Microsoft Windows Vista
Supported OS Microsoft Windows Vista x64
Microsoft Windows 7
Microsoft Windows 7 x64
Microsoft Windows 8
Microsoft Windows 8 x64
Microsoft Windows 10
Microsoft Windows 10 x64

Operating Temperature +5°C .. +60 °C
Storage Temperature -20 °C ... +60 °C
Relative Humidity (non-condensing) <90% rH
Mechanical

Size (without cables) 121mm x 66mm x 30mm
Weight (without cables) 119g

Available interfaces
USB Host interface USB 2.0, full speed
Ethernet Host interface 10/100 MBit
RS232 Host interface RS232 9-pin
Target interface JTAG 20-pin (14-pin adapter available)

JTAG Interface, Electrical

USB powered, 100mA for Flasher PRO. 500
mA if target is powered by Flasher PRO

Power Supply

Target interface voltage (VIF) 1.2 .5V
Target supply voltage Supply voltage is 5V, max.
Target supply current max. 400mA
Reset Type Open drain. Can be pulled low or tristated
Reset low level output voltage (VOL) VOL =< 10% of VIF
For the whole target voltage range (1.8V < VIF = 5V)
LOW level input voltage (VIL) VIL < 40% of VIF
HIGH level input voltage (VIH) VIH = 60% of VIF

For 1.8V = VIF = 3.6V

LOW level output voltage (VOL) with a load
of 10 kOhm

HIGH level output voltage (VOH) with a
load of 10 kOhm

VOL < 10% of VIF

VOH = 90% of VIF

For 3.6 = VIF = 5V

LOW level output voltage (VOL) with a load
of 10 kOhm

HIGH level output voltage (VOH) with a
load of 10 kOhm

VOL = 20% of VIF

VOH = 80% of VIF

JTAG Interface, Timing
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Max. JTAG speed up to 12MHz
Data input rise time (Trdi) Trdi < 20ns
Data input fall time (Tfdi) Tfdi < 20ns
Data output rise time (Trdo) Trdo < 10ns
Data output fall time (Tfdo) Tfdo < 10ns
Clock rise time (Trc) Trc < 10ns
Clock fall time (Tfc) Tfc < 10ns

1.2.4.1 Supported CPU cores
The Flasher PRO supports the following CPU cores:

ARM Cortex

Cortex-A5
Cortex-A8
Cortex-A9
Cortex-R4
Cortex-R5
Cortex-MO
Cortex-M0+
Cortex-M1
Cortex-M3
Cortex-M4

ARM (legacy cores)

ARM720T
ARM7TDMI
ARM7TDMI-S
ARMO920T
ARMO922T
ARM926E]-S
ARM946E-S
ARM966E-S
ARM1136]JF-S
ARM1136]-S
ARM1156T2-S
ARM1156T2F-S
ARM1176]Z-S
ARM1176]ZF
ARM1176]ZF-S

Renesas RX

RX111
RX210
RX220
RX21A
RX610
RX621
RX62G
RX62N
RX62T
RX630
RX631
RX63N
RX63T
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Freescale Power PC
e e200z0

1.2.4.2 Supported Target interfaces

The Flasher PRO supports the following target interfaces:
JTAG
SWD
FINE
SPD

1.2.4.3 Flasher PRO download speed

The following table lists the Flasher PRO performance values for writing to memory (RAM)
via the JTAG interface:

Hardware ARM7 memory download

Flasher PRO 720 Kbytes/s (12MHz JTAG)

Note

The actual speed depends on various factors, such as JTAG, clock speed, host CPU
core etc.
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1.2.5 Specifications for Flasher Compact

General
Microsoft Windows (x86/x64)
Supported OS Linux (x86/x64/Arm)
macOS (x86/Apple M1)
Operating Temperature +5°C .. +60 °C
Storage Temperature -20 °C ... +65 °C
Relative Humidity (non-condensing) <90% rH
Size (without cables) 70mm x 45mm x 18mm
Weight (without cables) 40g
USB Host interface USB 2.0 (Hi-Speed); Micro USB
Target interface JTAG 20-pin (14-pin adapter available)
Power Supply USB powered, 130mA (idle)
Target interface voltage (VIF) 1.2 .5V
Target supply voltage Supply voltage is 5V, max.
Target supply current max. 400mA
Reset Type Open drain. Can be pulled low or tristated
Reset low level output voltage (VOL) VOL < 10% of VIF
SPI, QSPI, 8051 C2, cJTAG, FINE, ICSP,
Supported target interfaces IIC, ISP, JTAG, PDI, SPD, SWD, SWIM,
UART, UPDI
Serial transfer rate between Flasher Com- | Up to 50 MHz (Depending on target inter-
pact and target face)
For the whole target voltage range (1.8V = VIF = 5V)
LOW level input voltage (VIL) VIL < 40% of VIF
HIGH level input voltage (VIH) VIH = 60% of VIF
For 1.8V = VIF = 3.6V
t?\{\glﬁéilngutput voltage (VOL) with a load VOL < 10% of VIF
Eg%Holfei/glk%JrEFr#t voltage (VOH) with a VOH > 90% of VIF
For 3.6 = VIF = 5V
E?\{\gliéﬂnﬁumm voltage (VOL) with a load VOL < 20% of VIF
EﬁHolfefglkoourEﬂqUt voltage (VOH) with a VOH > 80% of VIF

JTAG Interface, Timing

Data input rise time (Trdi) Trdi < 20ns
Data input fall time (Tfdi) Tfdi < 20ns
Data output rise time (Trdo) Trdo < 10ns
Data output fall time (Tfdo) Tfdo < 10ns
Clock rise time (Trc) Trc < 10ns
Clock fall time (Tfc) Tfc < 10ns

1.2.5.1 Supported CPU cores

The Flasher Compact supports the following CPU cores:
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ARM Cortex

Cortex-A5
Cortex-A8
Cortex-A9
Cortex-R4
Cortex-R5
Cortex-MO
Cortex-M0+
Cortex-M1
Cortex-M3
Cortex-M4

ARM (legacy cores)

ARM720T
ARM7TDMI
ARM7TDMI-S
ARMO920T
ARMO922T
ARM926E]-S
ARMO946E-S
ARM966E-S
ARM1136]JF-S
ARM1136]-S
ARM1156T2-S
ARM1156T2F-S
ARM11763Z-S
ARM1176JZF
ARM1176]ZF-S

Renesas RX

RX111
RX210
RX220
RX21A
RX610
RX621
RX62G
RX62N
RX62T
RX630
RX631
RX63N
RX63T

Freescale Power PC
e ¢e200z0

CHAPTER 1 Specifications

1.2.5.2 Flasher Compact download speed

The following table lists the Flasher Compact performance values for writing to memory

(RAM) via the JTAG interface:

Hardware

ARM7 memory download

Flasher Compact 720 Kbytes/s (12MHz JTAG)

Note

Flasher User Guide (UM08022)
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The actual speed depends on various factors, such as JTAG, clock speed, host CPU
core etc.
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1.2.6 Specifications for Flasher Portable PLUS

General

Supported OS

Microsoft Windows 2000
Microsoft Windows XP
Microsoft Windows XP x64
Microsoft Windows 2003
Microsoft Windows 2003 x64
Microsoft Windows Vista
Microsoft Windows Vista x64
Microsoft Windows 7
Microsoft Windows 7 x64
Microsoft Windows 8
Microsoft Windows 8 x64
Microsoft Windows 10
Microsoft Windows 10 x64

Operating Temperature

+5 °C ... +60 °C (normal operation)
+5 °C ... +45 °C (battery charging)

Storage Temperature

-20 °C ... +45 °C

Relative Humidity (non-condensing)

<90% rH

Power Supply

a) USB powered, 100mA for Flasher
Portable PLUS. 500 mA if target is powered
by Flasher Portable PLUS

b) Rechargeable 680mAh Li-Ion battery
(Sony US14500VR)

Charging via USB

70 minutes (at 1A charging current)

Mechanical

Size (without cables)

126mm x 70mm x 28mm

Weight (without cables) 140g
Available interfaces
USB Host interface usB 2.0

Target interface

Standard 20-pin 0.1" connector (Adapters
available).

Target Interface, Electrical

Target interface voltage (VIF)

1.2 ... 5V

Target supply voltage

Supply voltage is 4.5V, max. (depends on
the current battery voltage).

Target supply current

max. 400mA

Reset Type

Open drain. Can be pulled low or tristated

Reset low level output voltage (VOL)

VOL < 10% of VIF

For the whole target voltage range (1.8V = VIF = 5V)

LOW level input voltage (VIL)

VIL < 40% of VIF

HIGH level input voltage (VIH)

VIH = 60% of VIF

For 1.8V =

VIF = 3.6V

LOW level output voltage (VOL) with a load
of 10 kOhm

VOL < 10% of VIF

HIGH level output voltage (VOH) with a
load of 10 kOhm

VOH = 90% of VIF

For 3.6 = VIF = 5V

Flasher User Guide (UM08022)
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LOW level output voltage (VOL) with a load
of 10 kOhm

VOL < 20% of VIF

HIGH level output voltage (VOH) with a
load of 10 kOhm

VOH = 80% of VIF

JTAG Interface, Timing
Max. JTAG speed up to 12MHz
Data input rise time (Trdi) Trdi < 20ns
Data input fall time (Tfdi) Tfdi < 20ns
Data output rise time (Trdo) Trdo < 10ns
Data output fall time (Tfdo) Tfdo < 10ns
Clock rise time (Trc) Trc < 10ns
Clock fall time (Tfc) Tfc < 10ns

1.2.6.1 Supported CPU cores
The Flasher Portable PLUS supports the following CPU cores:

ARM Cortex

Cortex-A5
Cortex-A8
Cortex-A9
Cortex-R4
Cortex-R5
Cortex-MO
Cortex-M0+
Cortex-M1
Cortex-M3
Cortex-M4

ARM (legacy cores)

ARM720T
ARM7TDMI
ARM7TDMI-S
ARMO920T
ARMO922T
ARM926E]-S
ARMO946E-S
ARM966E-S
ARM1136]JF-S
ARM1136]-S
ARM1156T2-S
ARM1156T2F-S
ARM11763Z-S
ARM1176JZF
ARM1176]ZF-S

Renesas RX

RX111
RX210
RX220
RX21A
RX610
RX621
RX62G
RX62N
RX62T

Flasher User Guide (UM08022)
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RX630
RX631
RX63N
RX63T

Freescale Power PC
e ¢e200z0

1.2.6.2 Supported Target interfaces

The Flasher Portable PLUS supports the following target interfaces:

JTAG
SWD
FINE
SPD

1.2.6.3 Flasher Portable PLUS download speed

The following table lists the Flasher Portable PLUS performance values for writing to memory
(RAM) via the JTAG interface:

Hardware ARM7 memory download
Flasher PRO 720 Kbytes/s (12MHz JTAG)

Note

The actual speed depends on various factors, such as JTAG, clock speed, host CPU
core etc.
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1.2.7 Specifications for Flasher Portable

General

Microsoft Windows 2000
Microsoft Windows XP
Microsoft Windows XP x64
Microsoft Windows 2003
Microsoft Windows 2003 x64
Supported OS Microsoft Windows Vista
Microsoft Windows Vista x64
Microsoft Windows 7
Microsoft Windows 7 x64
Microsoft Windows 8
Microsoft Windows 8 x64

Operating Temperature +5°C .. +60 °C
Storage Temperature -20 °C ... +65 °C
Relative Humidity (non-condensing) <90% rH

a) USB powered, 100mA for Flasher
Portable. 500 mA if target is powered by
Flasher Portable

b) Batteries powered (3xAAA)

Power Supply

Mechanical
Size (without cables) 130mm x 65mm x 25mm
Weight (without cables) 120g
Available interfaces
USB Host interface USB 2.0
Target interface :\t/zriwlgzlrg).zo—pin 0.1" connector (Adapters

Target Interface, Electrical
Target interface voltage (VIF) 1.2 .. 5V

Supply voltage is 4.5V, max. (depends on

Target supply voltage the current battery voltage).

Target supply current max. 400mA
Reset Type Open drain. Can be pulled low or tristated
Reset low level output voltage (VOL) VOL < 10% of VIF
For the whole target voltage range (1.8V =< VIF < 5V)
LOW level input voltage (VIL) VIL £ 40% of VIF
HIGH level input voltage (VIH) VIH = 60% of VIF

For 1.8V = VIF = 3.6V

LOW level output voltage (VOL) with a load
of 10 kOhm

HIGH level output voltage (VOH) with a
load of 10 kOhm

VOL < 10% of VIF

VOH = 90% of VIF

For 3.6V = VIF = 5V

LOW level output voltage (VOL) with a load
of 10 kOhm

HIGH level output voltage (VOH) with a
load of 10 kOhm

VOL < 20% of VIF

VOH = 80% of VIF

JTAG Interface, Timing
Max. JTAG speed up to 12MHz
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Data input rise time (Trdi) Trdi < 20ns
Data input fall time (Tfdi) Tfdi < 20ns
Data output rise time (Trdo) Trdo < 10ns
Data output fall time (Tfdo) Tfdo < 10ns
Clock rise time (Trc) Trc < 10ns
Clock fall time (Tfc) Tfc < 10ns

1.2.7.1 Supported CPU cores

The Flasher Portable supports the following CPU cores:

ARM Cortex

Cortex-A5
Cortex-A8
Cortex-A9
Cortex-R4
Cortex-R5
Cortex-MO
Cortex-M0+
Cortex-M1
Cortex-M3
Cortex-M4

ARM (legacy cores)

ARM720T
ARM7TDMI
ARM7TDMI-S
ARMO920T
ARMO922T
ARM926E]-S
ARMO946E-S
ARM966E-S
ARM1136]JF-S
ARM1136]-S
ARM1156T2-S
ARM1156T2F-S
ARM11763Z-S
ARM1176JZF
ARM1176]ZF-S

Renesas RX

RX111
RX210
RX220
RX21A
RX610
RX621
RX62G
RX62N
RX62T
RX630
RX631
RX63N
RX63T

Freescale Power PC
e e200z0
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1.2.7.2 Supported Target interfaces

The Flasher Portable supports the following target interfaces:

JTAG
SWD
FINE
SPD

1.2.7.3 Flasher Portable download speed

The following table lists the Flasher Portable performance values for writing to memory
(RAM) via the JTAG interface:

Hardware ARM7 memory download
Flasher PRO 720 Kbytes/s (12MHz JTAG)

Note

The actual speed depends on various factors, such as JTAG, clock speed, host CPU
core etc.
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Working with Flasher

This chapter describes functionality and how to use Flasher.
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2.1 Flasher Portable PLUS

The Flasher Portable PLUS is a portable version of SEGGERs Flasher family, which has been
designed to fill the need of an extremely portable, production grade, Flash programmer
used for in-field firmware updates. No need to be tethered to an outlet, it is powered by
an integrated Li-Ion cell (680mAh). The Flasher Portable PLUS programs flash targets in
stand-alone mode or via J-Flash PC software.

Furthermore the Flasher Portable PLUS allows the user to select between eight data images
to be programmed. The images can be easily selected by using the SEL button on the front
of the housing. For more information about support for multiple images, please refer to
Multiple File Support on page 52.

For setup and configuration purposes, the Flasher Portable PLUS connects to a PC via USB
interface, running Microsoft Windows 2000, Windows XP, Windows 2003, Windows Vista,
Windows 7, Windows 8 or Windows 10 and has a built-in standard 20-pin J-Link target
connector.

Note

Ethernet and RS232 as host interface are not available for the Flasher Portable PLUS.

2.1.1 Housing & Buttons

The Flasher Portable PLUS comes with a display, which is for example used to represent
the status of an ongoing flash progress. Furthermore, there are three buttons which allow
the user to control Flasher Portable PLUS. For a detailed description of the functions, take
a look at the table below:

Power on / off

Program

Select image

Button Description

Start programming process with the currently selected im-

Program
age.
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Button

Description

Select image

Select the image to be programmed next time the Program
button is pressed.

Power on/off

Used to power-on / power-off the Flasher Portable PLUS.
Please note that to power up the Flasher Portable PLUS, the
button should be hold for at least 1 second to make sure
software can boot and take control of power circuit, so the
Flasher Portable PLUS keeps powered, after releasing the
button.

2.1.2 Configuration

The Flasher Portable PLUS has some configuration options the other Flashers do not have.

Option Description Value range DI
value
AutoPowerOf- Specifies the time interval after which the
Flasher Portable will turn off without any 1 to 3600 60
fOnldle .
user action
ShowDatCR- Activates displaying the data file CRC after | 0 = inactive, 1
CAfterProgram- S _ . 0
ming the programming in the pop up message = active

If the Fl asher. i ni does not contain a [ Confi g] section with the configuration option, the

default value is used.

Example:

This sample will show the data file CRC after the programming and the auto power of is
set to five minutes (=300 seconds).

[ CONFI G

Aut oPower OF f Onl dl e = " 300"
ShowDat CRCAf t er Programring = " 1"

Flasher User Guide (UM08022)
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2.2 Flasher Portable

The Flasher Portable is a portable version of SEGGERs Flasher family, which has been
designed to fill the need of an extremely portable, production grade, Flash programmer
used for in-field firmware updates. No need to be tethered to an outlet, it is powered by
three standard AAA batteries. The Flasher Portable programs flash targets in stand-alone
mode or via J-Flash PC software.

Furthermore the Flasher Portable allows the user to select between four data images to be
programmed. The images can be easily selected by using the arrow buttons on the front
of the housing. For more information about support for multiple images, please refer to
Multiple File Support on page 52.

For setup and configuration purposes, the Flasher Portable connects to a PC via USB inter-
face, running Microsoft Windows 2000, Windows XP, Windows 2003, Windows Vista, Win-
dows 7 or Windows 8 and has a built-in standard 20-pin J-Link target connector.

Note

Ethernet and RS232 as host interface are not available for the Flasher Portable.

2.2.1 Housing & Buttons

The Flasher Portable comes with several leds which are for example used to represent the
status of an ongoing flash progress. Furthermore, there are three buttons which allow the
user to control Flasher Portable. For a detailed description of the functions, take a look at
the two tables below:

A Target A
Program

ACTIVE
PASS/FAIL
Select image

Power on / off

Flasher

R e e O T S R
The rn circart Pro’r&mmer.'

Portable
e
SEGGER

www.segger.com
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LED

Description

ACTIVE

GREEN. Blinks while the Flasher Portable is busy / performs
operations on the target.

PASS/FAIL

GREEN/RED. Indicates, if the last flashing cycle was success-
ful.

e GREEN: Flashing cycle completed successfully.

e RED: Flashing cycle completed with error.

1/2/3/4

GREEN: Indicates which image is currently selected for pro-
gramming. For more information about multiple image sup-
port, please refer to Multiple File Support on page 52.

POWER

GREEN: Indicates if Flasher is currently powered. Blinks
while Flasher Portable tries to enumerate via USB.

LO BAT

1) The LED is off, meaning battery voltage is > 3.3V

2) The red LED is constant on if battery voltage is low (=<
3.3V). In this mode, Flasher still allows programming.

3) The red LED starts blinking in case of the battery voltage
is below 3.0V. Flasher refuse programming attempts.

Button

Description

Program

Start programming process with the currently selected im-
age.

Select image

Select the image to be programmed next time the Pr ogr am
button is pressed.

Power on/off

Used to power-on / power-off the Flasher Portable. Please
note that to power up the Flasher Portable, the button
should be hold for at least 1 second to make sure software
can boot and take control of power circuit, so the Flasher
Portable keeps powered, after releasing the button

Flasher User Guide (UM08022)
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2.3 File system

The Flasher supports 8.3 filenames only (8 characters filename, 3 characters file extension).
Using longer filenames may result in incorrect operation. Integrated functions, like the FTP
server or the terminal server, will refuse writing files with long filenames.
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2.4 Setting up the IP interface

Setting up the IP interface Some of the Flasher models come with an additional Ethernet
interface to communicate with the host system. These Flashers also come with a built-
in webserver which allows some basic setup of the emulator, e.g. configuring a default
gateway which allows using it even in large intranets. For more information, please refer
to TCP Services on page 75.

2.4.1 Connecting the first time

When connecting Flasher the first time, it attempts to acquire an IP address via DHCP. The
recommended way for finding out which IP address has been assigned to Flasher is, to use
the J-Link Configurator. The J-Link Configurator is a small GUI-based utility which shows
a list of all emulator that are connected to the host PC via USB and Ethernet. For more
information about the J-Link Configurator, please refer to UM08001_JLink.pdf (J-Link / J-
Trace user guide), chapter Setup, section J-Link Configurator. The setup of the IP interface
of Flasher is the same as for other emulators of the J-Link family. For more information
about how to setup the IP interface of Flasher, please refer to UM08001, J-Link / J-Trace
User Guide, chapter Setup, section Setting up the IP interface. For more information about
how to use Flasher via Ethernet or prepare Flasher via Ethernet for stand-alone mode,
please refer to Operating modes on page 39.
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2.5 Operating modes

2.5.

All Flashers except the Flasher ATE are able to boot in 3 different modes:

e PC-based mode
Stand-alone mode
File access mode

Note

The Flasher ATE only supports the stand-alone mode.

Definition PC-based mode

Flasher is connected to a PC via USB/Ethernet and controlled by a PC application (J-Flash).
If there is an RS232 connection to a PC, does not have any influence on if PC-based mode is
entered or not. In this mode, Flasher can be used as a J-Link and controlled by the software
in the J-Link software and documentation package (J-Link Commander, J-Flash, ...)

Definition Stand-alone mode

This mode is entered when there is no active USB/Ethernet connection to a host PC, e.g.
if Flasher is only powered via a USB power supply.

Definition file access mode mode

Entered only if Flasher Start/Stop button (on Flasher Portable the "PROG” button) is kept
pressed for at least 2 seconds while connection Flasher via USB. In this mode, Flasher
enumerates as a mass storage device (like an USB Stick) at the host PC. In this mode,
configuration + data files can be manually placed on the Flasher and the flasher logdfile
can be read out.

1 PC-based mode

If you want to use Flasher for the first time you need to install the J-Link software and doc-
umentation package. After installation, connect Flasher to the host PC via USB or Ethernet.
For more information about how to install the J-Link software and documentation package
please refer to the J-Link / J-Trace User Guide, chapter Setup which can be downloaded
from segger.com/jlink-software.html .

2.5.1.1 Connecting the target system

Power-on sequence

In general, Flasher should be powered on before connecting it with the target device. That
means you should first connect Flasher with the host system via USB / Ethernet and then
connect Flasher with the target device via JTAG or SWD. Power-on the device after you
connected Flasher to it. Flasher will boot in "PC-based mode”.

Verifying target device connection with J-Link.exe

If the USB driver is working properly and your Flasher is connected with the host system,
you may connect Flasher to your target hardware. Then start the J-Link command line
tool JLi nk. exe, which should now display the normal Flasher related information and in
addition to that it should report that it found a JTAG target and the targets core ID. The
screenshot below shows the output of JLi nk. exe.
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[l C:\Program Files (@6)\SEGGER\LinkARM_V458a\JLink.exe [r| = 3]

REGGER J-Link Commander U4.58a ('?' for help>

Compiled Dec 5 2812 18:38:27

DLL version V4.58a. compiled Dec 5 2812 18:38:88

Firmuware: J-Link ARM ~ Flasher ARM U3 compiled HNov 28 2812 18:

m| e

rdy : V3.8

5~N: 1638001808
Feature(s»: JFlash

IP-Addyr.: WMo configuration received wvia DHCP
UTarget = 3.267U

Info: TotallRLen = 4. IRPrint = BxB1

Found 1 JIAG device,., Total IRLen = 4:

#@ Id: 8x3FBFAFOF. IRLen: @4, IRPrint: Bx1, ARM?IDMI Core
Found ARM with core Id Bx3FBFBFBF <(ARM7?>

JTAG speed: 188 kHz

]J-Link>_

2.5.1.2 LED status indicators

In PC-based mode, there are also certain LED status codes defined:

# Status of LED Meaning
Flasher is waiting for USB enumeration or eth-
GREEN ernet link. As soon as USB has been enumer-
0 | high frequency blinking ated or ethernet link has been established, the
(On/Off time: 50ms => 10Hz) green LED stops flashing and is switched to
constant green.
0 GREEN Flasher enumeration process is complete and it
constant is ready to be controlled by a PC application.

2.5.2 Stand-alone mode

In order to use Flasher in “stand-alone mode”, it has to be configured first, as described
in Setting up Flasher for stand-alone mode on page 43. To boot Flasher in the “stand-
alone mode”, only the power supply to Flasher has to be enabled (Flasher should not be
connected to a PC). In the “stand-alone mode” Flasher can be used as a stand-alone flash
programmer.

Note

Flasher can only program the target device it was configured for. In order to program
another target device, you have to repeat the steps described in Setting up Flasher
for stand-alone mode on page 43.

2.5.2.1 LED status indicators

Progress and result of an operation is indicated by Flasher’s LEDs. The behavior is different
for J-Link and stand-alone mode. For a definition of the different modes, please refer to
Operating modes on page 39.
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The following table describes the behavior of the LEDs in stand-alone mode.

# Status of LED Meaning
0 GREEN Flasher waits for a start trigger to perform an oper-
constant ation in stand-alone mode.
Flashing operation in progress:
e Erasing (slow blinking on/off time: 80 ms => 6.25
Hz)
1 SIE\E/EIL\:inkin e Programming (slow blinking on/off time: 300ms
9 => ~1.67 Hz)
e Verifying (slow blinking, on/off time: 100ms =>
5 Hz)
GREEN constant, RED off: Operation successful.
GREEN: constant GREEN constant, RED constant: Operation failed
2 RED: of‘f or constant Goes back to state #0 automatically, but in case of
) operation failed, RED remains on until state #1 is
entered the next time.

Older Flasher models have a different behavior. The following serial number ranges behave
different from the table above Flashers with the following serial humber ranges behave
different and comply to the table below:

e 1621xxxxx (Flasher ARM V2)
e 1630xxxxx (Flasher ARM V3)
e 4210xxxxx (Flasher PPC V1)
e 4110xxxxx (Flasher RX V1)
# Status of LED Meaning
Flasher is waiting for USB enumeration or ether-
net link. As soon as USB has been enumerated or
ethernet link has been established, the green LED
GREEN . . .
. oo stops flashing and is switched to constant green. In
high frequency blinking o .

0 S _ stand-alone-mode, Flasher remains in the high fre-
(On/Off time: 50ms => blinki | #1 ] hed
10Hz) quency blinking state until state is reached.

Flasher goes to state #1 as soon as a #START com-
mand has been received via the ASCII interface or
the Start button has been pushed.

1 GREEN Connect to target and perform init sequence.
constant

Flashing operation in progress:
e Erasing (slow blinking on/off time: 80 ms => 6.25
Hz)
2 gE\E/EtI)\:inkin e Programming (slow blinking on/off time: 300ms
9 => ~1.67 Hz)
e Verifying (slow blinking, on/off time: 100ms =>
5 Hz)
GREEN constant, RED off: Operation successful.
. GREEN constant, RED constant: Operation failed
3 ggggg%fcgrnsgigiant Goes back to state #0 automatically, but in case of
) operation failed, RED remains on until state #1 is
entered the next time.
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2.5.3 File access mode

When pressing the Start/Stop button (for Flasher Portable PLUS PRG button) of the Flasher
while connecting it to the PC, Flasher will boot in the “file access mode”. This mode can be
used to downdate a Flasher firmware version if a firmware update did not work properly
and it can be used to configure Flasher for the “stand-alone mode”, without using J-Flash. If
Flasher has been configured for “stand-alone mode” as described in the section above, there
will be four files on the drive, FLASHER. CFG, FLASHER. DAT, FLASHER. LOG, SERI AL. TXT.

&

[m]FLASHER LOG

SERIAL.THT

FLASHER. CFG contains the configuration settings for programming the target device and
FLASHER. DAT contains the data to be programmed. FLASHER. LOG contains all logging infor-
mation about the commands, performed in stand-alone mode. The SERI AL. TXT contains
the serial number, which will be programmed next. J-Flash supports to configure Flasher
for automated serial number programming.

Currently, J-Flash does not support to configure Flasher for automated serial number pro-
gramming.

If you want to configure multiple Flasher for the same target you do not have to use J-Flash
all the time. It is also possible to copy the FLASHER. CFG and the FLASHER. DAT files from a
configured Flasher to another one. To copy these files boot Flasher in “file access mode”.
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2.6 Setting up Flasher for stand-alone mode

In order to set up Flasher for the stand-alone mode it needs to be configured once using the
J-Flash software. For more information about J-Flash, please refer to the J-Flash User Guide.

After starting J-Flash, open the appropriate J-Flash project for the target Flasher shall be
configured for, by selecting File -> Open Project. If J-Flash does not come with an ap-
propriate sample project for the desired hardware, a new project needs to be created by
selecting File -> File -> New Project.

After the appropriate project has been opened / created, the data file which shall be pro-
grammed needs to be loaded, by selecting File -> Open. After this J-Flash should look
like in the screenshot below.

KN SEGGER J-Flash ARM V4.58a - [C:\Pragram Files (x86)\SEGGER\LinkARM_V458a\Samples\JFlash\PrajectFiles\ ATO1 SAMTX256.flash] [r= |- ]
File Edit View Target Options Window Help
EProjr:ct-ATQl... = || B ER ETestdata (generated by J-Flash) * EI@
Name | Value Address: [0x100000  [w1 x2| x4
Connection USE [Device 0]
Target interface JTAG Address [ @ [1 [2 [3[4[5[6[?2[8[2[A[B|[C[D[E]|F [ASCII |£‘
1AAAAA | i @B @@ EA FE FF FF ER FE FF FF EA FE FF FF EA ...
Init JTAG speed 200 kHz 1AAA1A |FE FF FF EA @6 @@ OA@ 94 FE FF FF EA FE FF FF EA .
JTAG speed 12000 kHz 1AAAZA @@ 6@ AP E3 @1 7@ 87 E2 @1 6@ 86 E2 FD FF FF EA .
TAP number <rot useds 1AAA3A |@C PP AP BA @D PP PP AR GE AP AP GA OF @@ GO 6@ .
IRPre <rot useds 1ARA4A |19 PP AP BA 11 PP O AR 12 PP B BA 13 PR OB @A ... .-
1APASA |14 9P AP BA 15 PA DA AR 16 AP B BA 17 B0 A0 BA .. ..............
MCU Atmel AT 91 SAMTRI56 1AAAGA |18 PP AP AA 19 PA PA AA 1A AP B BA 1E B A B .........c..c...
Clack speed 47923200 Hz 1APA7 |1C 60 PP AP 1D P O B 1E A0 OG0 G@ 1F 86 88 @8 ... ... ..........
Endian Litle 1ARASA |27 PP AP BA 21 PA PA AA 22 AP AP B 23 0@ A BA ...t..."...H#...
Check coreld  Yes 1AAA%A |24 PP AP BA 25 PA DA GO 26 AP B G 27 00 A0 B 5...x...&..." ...
Core Id (x3FOFOFOF | 1PPAAP |28 OGP PP GG 29 00 OB BB 20 AP PO PO 2B B0 BB BB (.. .>...% .+,
se target RaM  Yes 1ABBBA (2C B8 6@ B 2D B8 B0 6P 2E B@ BB 6@ 2F 6@ @B @8 ,....—._...... e
RAM address  0w200000 1ARACA (3@ AP AP AA 31 PP O AR 32 AP AP BA 33 AA AA @A A...1...2...3..
RAM size G4 KR 1ARADA |34 9P AP BA 35 PP O A@ 36 PP B BA 37 A O @A 4...5...6...7..
1ARAEA |38 PP AP BA 39 PA PA AA 30 AP AP OA 3B @A A BA 8...9...:...5...
Flash memory  ATI1SAM7XI5G inter... 1AAAFA |3C 9P AP BA 3D PA P GA 3E AP BA GA 3F 0@ BB BA <...=...>...7...
Marufactarsr  Admel 1AR1iAR |49 PP AP BA 41 PP DA AR 42 PP B BA 43 P BB @A B...A...B...C..
Size 255 KB 1AP1iA |44 9P AP BA 45 PP O AR 46 PP AP BA 47 P BB @A D.._E...F...G..
Flash Id 0s0 1AA12A |48 AP AP AA 49 PP OA AR 47 PP B BA 45 AA A @A H...I...J...K..
Check flashld Mo 1AA13@ |4C 9P A0 BA 4D PP O AQ 4E PP B BA 4F A PA @A L...M...N...0..
Base address  0x100000 1AA14@ |50 PP AP AA 51 PA@ O AR 52 PP AP @A 53 MA@ M@ @A P...Q...R...5..
Drganization 22 bits # 1 chip 1AA15@ |54 @@ AP BA 55 PA OB @@ 56 PP B B@ 57 A BB @@ T...U...U_..W..
1ARi6A |58 PP PP BA 59 PP PP AR 5A AP AP BA 5B BP BB BA X...Y¥...Z...[...
« T v 186178 |5C @@ @9 @@ 5D A 9B @A SE @@ B8 BA S5F 00 @9 @0 ... 1...~..._ ... |
Kl oG o @[ =
- List of MCL devices read successfully (1564 Devices) -

Creating new project file [C:\Program Files 86" SEGGER JLink ARM_V458a"\Default jflash] ...

- New project created successfully

Close project

- Project closed

Opening project file [C:\Program Files (<B86)"SEGGER"LinkARM_V458a"%5amples'JFashProjectFiles'\ATS1.5AM7X256 flash] ...
- Project opened successfully

Generating test data ...

- 1024 of 1024 sectors selected, 1 range, (100000 - (e 13FFFF

- Test data generated successfully. (262144 bytes, 1 range) - Completed after 0.267 sec

m

Ready

Flasher User Guide (UM08022) © 2004-2021 SEGGER Microcontroller GmbH



44

Flasher User Guide (UM08022)

CHAPTER 2

Setting up Flasher for stand-alone mode

Before downloading the configuration (project) and program data (data file) to Flasher, the
connection type (USB/IP) needs to be selected in the project. These settings are also saved
on a per-project basis, so this also only needs to be setup once per J-Flash project. The
connection dialog is opened by clicking Options -> Project settings -> General.

Project settings

General | Target Interface ] CPU ] Flash | Production |

L2 [l

Uzer interface mode

{+ Engineering [More options, typically uzed for setup]

" Simplified [Less options, typically used for production)

J-Flash-4RM iz a software For J-Link ARM. It
requires a license, which can be obtained fram
SEGGER [www.zegger.comn).

Thiz software iz capable of programming the flash

memory of zeveral ARM micros, as well az
external Flash connected to ARM cores.

Connection to J-Link

Device 0 -
" USB SN |0

C ICPAP |

The connection dialog allows the user to select how to connect to Flasher. When connecting
to a Flasher via TCP/IP it is not mandatory to enter an IP address. If the field is left blank
and File -> Download to programmer is selected, an emulator selection dialog pops up
which shows all Flasher which have been found on the network. The user then can simply

select the Flash he wants to download the configuration to.

SEGGER J-Link V4 58a - Emulator selection ===

Mo emulators connected over USE. If pou want to connect over TCPAP instead, pleasze
zelect the emulator you want to connect to:

0 Fl: oo

J-Link &Fk-Pro 3,00
J-Link &Fk-Pro 3,00
J-Link &RM-Prov3.00
J-Link ARM-Prov3.00
J-Link ARM-Prav3.00
J-Link &RM-Pro v3.00
J-Link &Fk-Pro 3,00
J-Link &Fk-Pro 3,00
J-Link &RM-Prov3.00
0 J-Link ARM-Prov3.00

173001050 19216861
173001042 1327168.8.6

m

173001041 192716887
173001044 192716882
173001085 192716876
173001056 1927168.7.2
173001051 1927168.75
173001053 1927168.7.3
173001043 19271653.8.2 b=

10 3

A LD 0D OO O e L0 RO
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In order to download the configuration and program data to the Flasher, simply select File
-> Download config & data file to Flasher.

ﬂ SEGGER J-Flash ARM V4,583 - [C:\Program Files (x86)\SEGGER\LinkARM_V4583" 5amples\JFlash'\ProjectFiles\ AT91 SAMTX256.jflash]
Edit View Target Options Window Help
Open data file... Ctrl+0

erated by J-Flash) *
Merge data file...

Save data file Ctrl+5 - E g g

L
. l[1[2]3[a[s[e|[?[8|929 na|B|c|D|E]|F[ascIiI
ave cata Tile as... 5 88 B0 En FE FF FF En FE FF FF En FE FF FF En
) E FF FF En B6 @@ @@ 94 FE FF FF En FE FF FF En
Mew project A 6@ A@ E3 @1 7@ 87 E2 @1 @ 86 E2 FD FF FF En
OpepioEcs C P AP AA AD OA BA PA OE M@ BP OA GF 9@ 0@ A8
= A PP 0P A i1 OA DA 9P 12 A PP OA 13 9@ 0@ OO
Save project 190 OGP AR 15 OA PA 9@ 16 AA AP OA 17 @A G@ A@
ST 3 00 OO B0 19 0P B0 PO 1A B0 0P 0P 1P 0O OO OO0
- C 9@ B0 AA 1D OA @@ 9@ 1E @A B9 OA 1F 9@ B0 @@
Close project A PA B0 AA 21 OA B 9@ 22 AA BP OA 23 9@ OO A6
1 P B@ AA 25 OA BA PA 26 MA@ GP OA 27 9@ 0@ A@
Save Flasher config file... 3 PP 0P A 29 OA DA @A 20 P PP OA 2B 9P 0@ OO
i C P A@ AA 2D OA PA 9@ 2E AA AP GOA 2F @A 0@ A@
Save Flasher data file P 0F BB 31 P@ O PO 32 B9 BP PA 33 00 6P B B...1...2...3...
Download config & data file to Flasher I 00 P9 AP 35 9P BP GO 36 AP OA @@ 37 B0 A @@ 4...5...6...7...
60 A@ @@ 39 AP 9@ B0 3n OGP BA A 3B B0 @ @@ B...9...:...;...
Download senal nurnber file to Flasher C P B@ AA 3D OA P 9@ 3IE AA PP GA 3F 98 B8 @@ <...=...>...7...
A PP 0P PB 41 OO PA 9P 42 PO PP OA 43 9@ B@ A @...A...B...C...
Export setup file... 190 @ AR 45 OA PA @@ 46 AR PP BA 47 @@ B@ @A D.._E...F...G...
3 00 OO B0 49 0D B0 OO 47 B0 0P OB 4B OO 680 ©0 H...I...J...K...
Recent Files ) C 0@ B9 @A 4D PO BR A 4E @A @@ B@ 4F @ 0P @A L...M...N...0...
. AP B0 AA 51 OA A 9@ 52 A PP GA 53 9@ @@ @@ P...Q...R...S...
Recent Projects 1090 P AA 55 PA BB AA 56 GA AR BA 57 6@ @8 @A T...U...U_._.W...
3 PP 0P AB 59 OA PA @@ SN PO PP OA SB @@ 6@ BB X...Y...Z...[...
Exit Alt+F4 © 90 99 B0 5D DA 9O B@ SE B B0 B8 SF 60 08 @0 ~...1...". .. _... j
1
Bl oG o |[= ] =

- List of MCL devices read successfully (1964 Devices) -
Creating new project file [C:\Program Files (&x86)"SEGGER"Link ARM_V458a"\Defautt jflash] ...

- New project created successfully

Close project

- Project closed

Opening project file [C:\Program Files (<B6)\SEGGER")LinkARM_V458a"5amples'JFash"ProjectFiles \ATS1SAM7X256 flash] ...
- Project opened successfully

Generating test data ...

- 1024 of 1024 sectors selected, 1 range, (100000 - (e 13FFFF

- Test data generated successfully. (262144 bytes, 1 range) - Completed after 0.261 sec

m

Download current configuration to programmer
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The J-Flash log window indicates that the download to the emulator was successful.

Kl SEGGER J-Flash ARM V4.58a - [C:\Program Files (x86)\SEGGER\LinkARM_V458a\Samples\JFlash\ProjectFiles\ATS1 SAM7 X256 jflash 7] =] e
File Edit View Target Options Window Help
Bl project- AT91... [ = || @ |[ 22 | | B Test data (generated by J-Flash) * ===
Mame | Value Address: [0x100000  [w1 x2| x4
Connection USE [Device 0]
Target interface SwD Address [ @ [1 [2 [3[4[5[6[?2[8[2[A[B|[C[D[E]|F [ASCII |£‘
1PPABA |26 ©9 B8 EA FE FF FF EA FE FF FF EA FE FF FF BEA -v.cceeucceeness
Irit JTAG speed 200 kHz 188@18 |FE FF FF EA 86 B8 88 94 FE FF FF EA FE FF FF EA .. ..............
JTAG speed 12000 kHz 19@A28 |G 6@ @ E3 B1 70 87 E2 B1 60 86 E2 FD FF FF EA _'...p... ......
TAP number <ot useds 18P930 |GC B B B9 BD PO BP 00 BE G B9 VO OF B0 00 B8 ... ............
= <ot useds 1PPA40 |16 GG G0 @9 11 90 G 9@ 12 G0 GO 0 13 G0 0O 600 .. .-
1P@A50 |14 PG B0 B9 15 PO G 0@ 16 G0 B 0@ 17 00 OO 0O .
MCU Atmel AT 51 SAM 7RG 1PPAcA |18 P9 B @9 19 VA BB @0 1n OO B9 ©A 1B 6@ B9 08 .
Clack speed 47973200 Hz 199A7A |1C 99 B@ @9 1D VA BA 90 1E 60 B9 ©@ 1IF 60 09 08 .
Endian Litle 1PEASA |26 GG B @0 21 B0 B GG 22 G0 B9 G 23 G0 B0 08 ..
Check coreld  ‘es 19PA9@ |24 B0 GO @@ 25 B0 GO B0 26 G0 B0 B 27 G0 60 08 §..
Care Id 0%3FOFOFOF 1P@0AAA |28 @@ GO @@ 29 V0 B @@ 20 G0 B @0 2B B0 OO 08 C...>...%
Use target R Yes 1GPPEG |2C GG G @@ 2D PO 0P G0 2E @@ 6@ VA 2F 60 60 60 .. .. —.......
FaM addiess  0x200000 1PPACA |30 P9 A @9 31 VA BB 90 32 B0 B9 ©A 33 6@ 6P @@ B...1...2...3.
FiM size EAKE 199ADA |34 B9 B@ 99 35 V0 GO 90 36 B0 B9 O@ 37 60 B9 @8 4...5...6...7.
1PPAEA |38 0@ BA @0 39 V0 BA B0 30 G0 B0 G0 3B 60 B0 OB 8...9...:...;...
Flash memory  ATI1SAM7XI5G inter... 1P@AFA |3C B9 GG 9@ 3D V0 GO 90 3E G0 B0 B0 3F 60 60 08 <...=...>...7...
Manufactursr  Atmel 1PP160 |40 @ G0 B0 41 PO G 0@ 42 90 G OG0 43 9@ O G0 G...A...B...C..
Size 256 KB 199110 |44 @ GO @@ 45 PO G G0 46 00 G @@ 47 0@ O 60 D...E...F...G..
Flash Id 040 1PMi28 |48 ©9 B @0 49 PO BB OO 47 OO B ©A 4B B0 60 @0 H...[...J...K..
Check flashld Mo 199138 |4C 99 B8 @9 4D VO BB 90 4E 90 B9 ©@ 4F 9@ @9 @@ L...M__.N_..0..
Base address  0x100000 19Pi4@ |50 @ BB @@ 51 VA BB 9O 52 B0 B BA 53 B6 G 60 P...Q...R...S..
Drganization 22 bits # 1 chip 1@@i5@ |54 9@ B @@ 55 B0 G 90 56 B0 G B0 57 B0 60 60 T...U__.U_..Y._.
1P@1i6A |58 @@ GO @@ 59 90 G @@ Sn G0 B @G 5B 60 OO 08 X...¥Y...Z...[...
« i y 186178 |5C @@ @9 @@ 5D A 9B @A SE @@ B8 BA S5F 00 @9 @0 ... 1...~..._ ... |
El oG o |[=][=
- Project opened successfully -

Generating test data ...
- 1024 of 1024 sectors selected, 1 range, (100000 - (&ke13FFFF
- Test data genected euccessh ly (253144 butes 1 mnge) - Completed after 0.261 sec
Downloading files to emulator...
Downloading files to emulator...
- Downloading "Flasher.cfg” (2048 bytes) ...
- File downloaded successfully
- Downloading "Flasher.dat” (266240 bytes) ...
- File downloaded successfully

m

Ready

From now on, Flasher can be used in stand-alone mode (without host PC interaction) for
stand-alone programming.

2.6.1 Preparing for stand-alone operation manually

As an alternative, J-Flash can also be used to save config and data file to a hard drive.

This files can later be copied to a Flasher without using J-Flash, which is useful to prepare
additional Flasher for stand-alone programming, if for example a company plans to widen
its production, new Flasher units can be bought and used in production by simply copying
the files to the new units.

Creating config and data files

J-Flash config (*.CFG) and data (*.DAT) files can be created by using the “Save Flasher
config file..” and “Save Flasher data file...” options in the “File” menu.

For some devices, additional files (*.PEX) are needed. J-Flash will create a subdirectory (in
the same directory as the config file) with the same name as the config file and place the
files needed in this directory.

About *.PEX files

When using the “Save Flasher config file...” menu point or when using the “multiple config-
urations stored on Flasher” feature (See Multiple File Support on page 52.) feature, the
following needs to be taken care of:

For some devices, special connect, reset etc. sequences are necessary which are stored in
so-called *.PEX files on the Flasher.

When using the “"Download config & data file to Flasher”, J-Flash takes care of correct use
and download of these files to Flasher.
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When creating the config files manually and later download them to the Flasher manually,

it is user’s responsibility to put them at the right place.

The *.PEX files need to be placed in a subdirectory with the same name as the corresponding
*.cfg file. J-Flash creates a directory with the correct name automatically when a config

file is created.

Example:

MyConf0 is a project for a device that requires a *.PEX file for connect.

MyConfl is a project for a device that requires no *.PEX file at all.

Kl J-Link Commander 5.12d

SEGGER J-Link Commander U5.12d (Compiled Apr 26 2016 19:2@0:11>
DLL version U5.12d,. compiled Apr 26 2816 19:19:35

Connecting to J-Link via USB...0.K.

Firmware: J-Link ARM ~ Flasher ARM U4 compiled May 3 2816 @8:29:34
Hardware version: U4.80

S/N: 164205426

Licensef¢s):= JFlazh, GDB

IP-Addr: 255.255_255.255 (DHCP>

UTref = O.088U

"connect' to establish a target connection, %' for help
J-Link>flist
FLASHER. INI Size:z 127
MYCONF_A_.DAT Size: 2662408
MY CONF_1 .CFG Size: 4096
MYCONF_1 .DAT 8ize: 2115584
MY CONF_@
MY CONF_B~CONMNECT . PEX Size:- 588
MY CONF_A.CFG Size: 4096

WJ—Link>
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2.7 Universal Flash Loader mode

As an alternative to the stand-alone mode, configured via J-Flash, there is the Universal
Flash Loader mode. While the normal stand-alone mode relies on using the debug interface
of the device, the Universal Flash Loader mode uses device or vendor specific programming
interfaces and protocols and therefore it is independent of the CPU core.

The Universal Flash Loader is available for the following Flasher models:

e Flasher PRO
e Flasher Compact
e Flasher Portable PLUS

For some of the supported devices, SEGGER offers specific adapters.

2.7.1 Preparing manually

The Universal Flash Loader uses an initialization file (*.UNI), a device specific flash pro-
gramming algorithm (*.PEX) and a data file (*.HEX, *.MOT, *.BIN or *.DAT).

2.7.1.1 Configuration

The initialization file basically is split into three parts. The first part, the section [DEVICE],
controls the generic behavior of the Universal Flash Loader. It specifies which protocol
driver and data file to use. It allows enabling and configuring target power and it defines
which actions to perform. The second part consists of one or more [BANKXx] sections, which
contain information about the memories. The third part, the section [CONFIG], includes
configuration settings for the protocol driver.

An .ini file might look as follows:

[ OPTI ONS]
Tar get Power = "Q"
Chi pEr ase = "0"
[ TASKS]
CheckBlank = "1"
Er ase s 24
Pr ogr am s 24
Verify s 24
Secure = "1"
[ DEVI CE]
Al go = "RL78. PEX"
Dat a = "ALL_6Kk. not "
O fset = "0x00000000"
[ BANKO]
Code Fl ash
Base = "0x00000000"
Si ze = "0x00004000"
Sect = "0x00000400"
[ BANK1]
Dat a Fl ash
Base = "0x000F1000"
Si ze = "0x00000800"
Sect = "0x00000400"
[ CONFI G

BaudRate = "1000000"

Cl ear Confi gOnConnect = "0x00"
Security = "OxFF"

ShieldStart = "0x0000"

Shi el dEnd = " 0x000F"
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[OPTIONS]

TargetPower

If set to a value >0, power is applied to the target. The value defines the delay (in ms)
after enabling the target power supply and before starting to communicate with the target.

ChipErase

If set to 1, the chip erase function is called for erasing the chip.

Note

Do not enable this setting if the flash programming algorithm does not support chip
erase.

[TASKS]
CheckBlank

Defines if a blank check should be performed before erasing a sector.

Erase

Defines if the sector should be erased before programming.

Program

Defines if the sector should be programmed.
Verify
Defines if the sector should be verified after programming.

Secure

Defines if the device should be secured or protected against read-out after verifying.
[DEVICE]

Algo

File name of the flash programming algorithm. This file is provided by SEGGER and will
typically support a series of devices.

Data

File name of the data file to program. The flasher supports the Flasher DTA, the Intel HEX,
the Motorola S-Record and the binary file format. Flasher DAT files are generated by J-Flash
and offer high performance together with high flexibility. The other file formats produce a
small overhead, because they have to be parsed before the data can be programmed.

Offset

Offset to apply when programming a binary data file. Unless specified differently, binary
files start at offset 0x00000000.

[BANKX]

x blocks with configuration data for the flash banks. All three parameters (Base, Size and
Sect) are mandatory.

Base

Base address of the flash bank.
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Size
Total size of the flash bank.
Sect

Sector size of the flash bank.

[CONFIG]

This section includes specific configuration data for the flash programming algorithm.
There are no general parameters.

Note

The data file must be organized in ascending address order. Gaps can be included. But
descending addresses will result in programming errors. You can sort the data files by
loading them into the J-Flash tool and saving it as a new file.
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2.7.2 Preparing using the PC utility

In order to set up Flasher for the Universal Flash Loader mode, a PC utility called SEGGER

Universal Flash Loader Configurator is available for download.

-

SEGGER Universal Flash Loader Confi

R5F104PJAFE

gurator V2,10

(2|

(]

Flazh Bank Loader Start Address

Code Flash RLV8.PEX 0:00000000
Data Flash  RL78.PEX 0:000F1000

Universal Flash Loader mode

*.bin|.hex|.mot]|.s].s19].srec

Download

Log initialized

End Address  Sector Size Size
0:0003FFFF  0x00000400 256 KiB
O:000F2FFF  0:00000400 8 KiB
SEGGER Universal Flash Loader Configurator V210 - Device selection ==
Vendor Device FlashBanks -~
Renesas RSF104PGGFB 128 KiB + 8 KiB
Renesas RSF104PHAFA 192 KiB + 8 KiB
Renesas RSF104PHAFB 192 KiB + 8 KiB
Renesas RSF104PHDFA 192 KiB + 8 KiB
Renesas RSF104PHDFB 192 KiB + 8 KiB
Renesas RSF104PHGFA 192 KiB + 8 KiB
Renesas RSF104PHGFB 192 KiB + 8 KiB
Renesas RSF104PIAFA 256 KiB + 8 KiB
Renesas  [RSFIO4PIAFB [ 256KiB+8KB |
Renesas RSF104PIDFA 256 KiB + 8 KiB
Renesas RSF104PIDFB 256 KiB + 8 KiB
Renesas RSF104PIGFA 256 KiB + 8 KiB
Renesas RSF104PIGFB 256 KiB + 8 KiB
Renesas RSF104PKAFA 384 KiB + 8 KiB 15
Renesas RSF104PKAFE 384 KiB + 8 KiB L
Renesas RSF104PKGFA 384 KiB + 8 KiB
Renesas RSF104PKGFB 384 KiB + 8 KiB
Renesas RSF104PLAFA 512 KiB + 8 KiB
Renesas RSF104PLAFB 512 KiB + 8 KiB
Renesas RSF104PLGFA 512 KiB + 8 KiB
Renesas RSF104PLGFB 512 KiB + 8 KiB
Renesas R5F1056AA5P 16 KiB + 2 KiB
Renesas R5F1056AGSP 16 KiB + 2 KiB
Renesas RSF1057AANA 16 KiB + 2 KiB
Renecac REE1NSTAGK A 1A KiB + 2 KiR ke
[ oK ] l Cancel l

The Universal Flash Loader Configurator comes with a large list of devices and flash pro-
gramming algorithms. If you are going to use a device from one of the supported families
which currently is not available in the utility, feel free to contact the support.
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2.8 Multiple File Support

It is also possible to have multiple data files and config files on Flasher, to make Flasher
more easy to use in production environment. To choose the correct configuration file and
data file pair, a FLASHER. I NI file is used. This init file contains a [ FI LES] section which
describes which configuration file and which data file should be used for programming. A
sample content of a FLASHER.INI file is shown below:

[ FI LES]
DataFile = "Fl asher1. dat"
ConfigFile = "Flasherl.cfg"

Using this method all configuration files and data files which are used in the production
only have to be downloaded once. From there on a configuration file / data file pair can
be switched by simply replacing the FLASHER. | NI by a new one, which contains the new
descriptions for the configuration file and data file. The FLASHER. | NI can be replaced in
two ways:

1. Boot Flasher in file access mode in order to replace the FLASHER. | NI

2. If Flasher is already integrated into the production line, runs in stand-alone mode and
can not be booted in other mode: Use the file I/O commands provided by the ASCII
interface of Flasher, to replace the FLASHER. | NI . For more information about the file I/
O commands, please refer to File I/O commands on page 87.

Note

Flasher supports 8.3 filenames only (8 characters filename, 3 characters file exten-
sion). Using longer filenames may result in incorrect operation.

2.8.1 Flasher Portable specifics

Flasher Portable allows to choose between four configuration and data file pairs during
runtime by using the select/arrow button on the front of Flasher Portable.

Which config / data file pair is used for which image selection position is determined by the
contents of the FLASHER.INI. For this, the FLASHER.INI contents in the [ FI LES] section
have been extended. The sample below shows how to enable the user to select between
four different images on the Flasher portable via the select / arrow button:

[ FI LES]

DataFile = "First.dat"
ConfigFile = "First.cfg"
Dat aFil el = "Second. dat"
ConfigFilel = "Second. cfg"
DataFile2 = "Third. dat"
ConfigFile2 = "Third. cfg"
Dat aFi |l e3 = "Fourth. dat"
ConfigFile3 = "Fourth. cfg"

Using this method, all configuration files and data files which are used in the production

only have to be stored on Flasher Portable via file access mode. From there on, switching
between the files can be done by simply using the selection button of Flasher Portable.
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2.8.1.1 Example

1 Target, 2 Datafiles (e.g. boot loader und application) --> same configuration file (*.CFG)
but different data files (*.DAT) should be used.

Open pre-configured J-Flash project

File -> Save Flasher config file ... (DEFAULT.CFG)

Open data file 1 (boot loader)

File -> Save Flasher data file ... (BOOT.DAT)

Open data file 2 (application)

File -> Save Flasher data file ... (APP.DAT)

Create the a FLASHER.INI file (content see below)

Connect the Flasher in file access mode to the PC

Copy DEFAULT.CFG, BOOT.DAT, APP.DAT and FLASHER.INI on the Flasher

FLASHER.INI content:

[ FI LES]

Dat aFi | e = "BOOT. DAT"
ConfigFile = "DEFAULT.CFG'
DataFilel = "APP. DAT"
ConfigFilel = "DEFAULT. CFG'

2.8.2 Flasher Portable PLUS specifics

Flasher Portable PLUS allows to choose between 16 configuration and data file pairs during
runtime by using the select button on the front of Flasher Portable PLUS.

Which config / data file pair is used for which image selection position is determined by
the contents of the FLASHER.INI. For this, the FLASHER.INI may contain several [ BATCH|
sections. The sample below shows how to enable the user to select between five different
images on the Flasher Portable PLUS via the select / arrow button:

[ BATCH|

DataFile = "First.dat"
ConfigFile = "First.cfg"
[ BATCHL]

Dat aFi | e = "Second. dat "
ConfigFile = "Second. cfg"
[ BATCH2]

DataFile = "Third. dat"
ConfigFile = "Third.cfg"
[ BATCH7]

DataFile = "Proj_8.dat"
ConfigFile = "Proj_8.cfg"
[ BATCH15]

DataFile = "Proj_16.dat"
ConfigFile = "Proj_16.cfg"

Using this method, all configuration files and data files which are used in the production only
have to be stored on Flasher Portable PLUS via file access mode. From there on, switching
between the files can be done by simply using the selection button of Flasher Portable PLUS.

Please also consider the chapter Batch Programming in stand-alone mode on page 58.

Note

There the Flasher Portable PLUS checks if the files exist on its flash storage. If the
a file is missing the entry will be skip and the selection jumps directly to the next
entry in the list.
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Note

next config

Note

uration.

2.8.2.1 Example

1 Target, 2 Datafiles (e.g. boot loader und application) --> same configuration file (*.CFG)

but different data files (*.DAT) should be used.

Open pre-configured J-Flash project

File -> Save Flasher config file ... (DEFAULT.CFG)

Open data file 1 (boot loader)

File -> Save Flasher data file ... (BOOT.DAT)

Open data file 2 (application)

File -> Save Flasher data file ... (APP.DAT)

Create the a FLASHER.INI file (content see below)

Connect the Flasher in file access mode to the PC

Copy DEFAULT.CFG, BOOT.DAT, APP.DAT and FLASHER.INI on the Flasher

FLASHER.INI content:

[ BATCH|

Dat aFi | e
ConfigFile
Di pl ayName
[ BATCHL]

Dat aFi | e
ConfigFile
Di pl ayName
[ BATCH2]

Dat aFi | e
ConfigFile
Dat aFi | el
ConfigFilel
Di pl ayNanme =

Flasher User Guide (UM

" BOOT. DAT"

" Boot | oader "

" APP. DAT"

" DEFAULT. CFG'

" Appl i cati on”
" BOOT. DAT"

" APP. DAT"

"BL and App"

08022)

CHAPTER 2

" DEFAULT. CFG'

" DEFAULT. CFG'

" DEFAULT. CFG'

Multiple File Support

You may have gaps in the list. The missing entries will be skipped when selecting the

The [ Fi | es] section is supported by the Flasher Portable PLUS, too. But the number
of configuration is limited to four.
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2.9 Custom labels

Flasher supports to assign custom labels to configurations. This allows to specify easy to
remember names for configurations that are stored on the Flasher.

2.9.1 Hardware and software requirements

This feature is supported by the following models:
e Flasher Portable PLUS

This feature is supported since V6.30e of the software package and firmware

2.9.2 Assigning labels

The configuration and data file pairs are specified in the FLASHER. | NI file:

[ FI LES]

Dat aFi | e = "1 MAGEO. dat "
ConfigFile = "IMAGEO. cfg"
DataFilel = "I MAGEL.dat"
ConfigFilel = "I MAGEL. cfg"

By default, Flasher will show the names of the configuration and data file:

LET[N TMAGE1 . cfq
IMAGE1.dat
2818-82-15 17:34

Image pluiIH¥. e
2 IMAGE2.dat
2018-82-15 17:34

By adding Di spl ayNane, Di spl ayNanel, ... keys to the FLASHER. | NI , a custom label can
be shown instead:

[ FI LES]

Di spl ayName = "FW smartwat ch"
Dat aFil e = "] MAGEO. dat "
ConfigFile = "IMAGEO. cfg"

Di spl ayNamel = "FWsnart neter"
Dat aFi | el = "] MAGEL. dat "
ConfigFilel = "IMAGEL cfg"

The images will now be shown as follows:
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ILETI[ FY smartwatch

1 2018-82-15 17:34

2.9.3 Considerations

e The maximum length of a custom label is 32 characters. If this length is exceeded, the
label is ignored and Flasher switches back to default mode for the affected configuration.
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2.10 Programming multiple targets

It is possible to program multiple targets which are located in a JTAG chain. The targets
will be programmed each with a configuration and a data file. The configuration for the
desired target must be selected before it can be programmed, this can be done with the
#SELECT command. For more information how to use the #SELECT command please refer
to Chapter “3.3.5 Commands to Flasher”.

Example
Three devices should be programmed.
JTAG Chain: TDI --> Device2 --> Devicel --> Device0 --> TDO

Three configurations would be stored on the flasher:

Config 0: Configured to program Device0 (DEVICEO.CFG, DEVICEQ.DAT)
Config 1: Configured to program Devicel (DEVICE1.CFG, DEVICE1.DAT)
Config 2: Configured to program Device2 (DEVICE2.CFG, DEVICE2.DAT)

Selection and programming of the target will be done via the ASCII interface:

#SELECT DEVI CEO
#AUTO
#SELECT DEVI CEl
#AUTO
#SELECT DEVI CE2
#AUTO

2.10.1 Programming multiple targets with J-Flash

Programming multiple targets can also be done via J-Flash using the command line inter-
face. For this each target must be handled with its own project file.

Example

JFl ash. exe -openproj "Device0.jflash" -open"Device0. hex" -auto -exit
JFl ash. exe -openproj "Devicel.jflash" -open"Devicel. hex" -auto -exit
JFl ash. exe -openproj "Device2.jflash" -open"Device2. hex" -auto -exit
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2.11 Batch Programming in stand-alone mode

Batch programming allows to execute different stand-alone mode jobs in batch to be exe-
cuted in immediate succession, without any user interaction in between. This can be used
for example to program multiple targets in a JTAG-Chain or multiple data files to a target.
A batch may contains an unlimited number of configurations which consist of a data file
(*.DAT) and config file (*.CFG). For further information regarding config and data files,
please refer to Preparing for stand-alone operation manually on page 46.

In order to specify the batch jobs, a FLASHER.INI file is used. This init file contains a
[BATCH] section which describes which configuration pairs (*.DAT and *.CFG file) should
be used for each batch job. A sample content of a FLASHER.INI file is shown below:

[ BATCH|

DataFil e = "Fl asher0. dat"
ConfigFile = "FlasherO. cfg"
Dat aFil el = "Fl asher1. dat"
ConfigFilel = "Fl asher1. cfg"

Batch ot
Flasher8.CFG
2019-81-14 15:25

Ready

LTret = 3.2941)

The Flasher Portable PLUS screen will show that the number of jobs contained in the batch
and the configuration file name of the first job.

Jobs: 2

Flasherd.CFG

2019-01-14 15:25
Addr: BxB080580Q

moox{F 172
Programming...

The progress will be shown during the flashing action. The Flasher lists the current job of
the batch, the current sector address and the percentage of the currently executed action.

Batch ot
Flasher8.CFG
2019-81-14 15:25

The result of the programming will be shown on the screen after finishing all jobs.
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Creating / Replacing of the FLASHER.INI file can done in two ways:

1.
2.

Boot Flasher in file access mode in order to replace the FLASHER.INI

If Flasher is already integrated into the production line, runs in stand-alone mode and
can not be booted in other mode: Use the file I/O commands provided by the ASCII
interface of Flasher, to replace the FLASHER.INI . For more information about the file
I/0 commands, please refer to File I/O commands on page 87. In case of an error
occurred during execution, the Flasher terminates the entire batch processing.

Note

Please note that the batch programming feature can not be used with the multiple file
support feature. Therefore, neither the #SELECT ASCII command nor the [FILES] tag
in the FLASHER.INI file can be used.

Note

Flasher supports 8.3 filenames only (8 characters filename, 3 characters file exten-
sion). Using longer filenames may result in incorrect operation.

2.11.1 Flasher Portable specifics

Flasher Portable allows to choose between four different batches during runtime by using
the select/arrow button on the front of Flasher Portable. Which batch configuration is used
for which image selection position is specified in the FLASHER.INI. For this, the FLASHER.INI
contents in the [BATCH] section have been extended. The sample below shows how to
enable the user to select between four different batches on the Flasher Portable via the

select / arrow button:

[ BATCH|

Dat aFi |l e = "Fl asher0. dat"
ConfigFile = "FlasherO. cfg"
Dat aFil el = "Fl asher 1. dat"
ConfigFilel = "Flasherl. cfg"
Dat aFi | e2 = "Fl asher2. dat"
ConfigFile2 = "Flasher2. cfg"
[ BATCHL1]

Dat aFil e = "TEST. dat "
ConfigFile = "Test.cfg"

[ BATCH2]

Dat aFi |l e = "VALI DATE. dat "
ConfigFile = "FlasherO. cfg"

Using this method allows to have different batches for different setups used in the produc-
tion to be stored once on the Flasher Portable via file access mode. From there on, switching
between the batches can be done by simply using the selection button of Flasher Portable.
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2.11.2 Examples

Example 1: Programming two Data files to the same target

Open your J-Flash project.
Use File -> Save Flasher config file... to save the .CFG file (in this example:
STM32F4.CFG).

e Select the first binary and use File -> Save Flasher Data file... to save the first .DAT file
(in this example: DATAOQ.DAT).

e Select the second binary and use File -> Save Flasher Data file... to save the second
data file .DAT file (in this example: DATA1.DAT).
Copy the Files to the Flasher e.g. by using file access mode.

e Create a FLASHER.INI file in the root directory of the Flasher.

e Exemplary content of FLASHER.INI:

[ BATCH|

Dat aFi | e = " DATAO. dat "
ConfigFile = "enmPower. cfg"
Dat aFi | el = "DATAL. dat"
ConfigFilel = "enPower.cfg"

Example 2: Programming one Data file to the first target in a JTAG-Chain and then pro-
gramming two data files to another device in the JTAG chain.
Example scenario: 2 Devices in a JTAG chain, a STM32F1 and a STM32F4.

Follow the same as described before and additionally:
Create one project file per target (and create a .CFG file of each one).

e Make sure each project file is configured correctly, especially the JTAG-Chain position
(See UM8003 “J-Flash” for more detailed info).

e Exemplary content of FLASHER.INI:

[ BATCH|

Dat aFi |l e = "F1DATA. dat"
ConfigFile = "STMB2F1. cfg"
Dat aFi | el = "FA4DATAO. dat"
ConfigFilel = "STM32F4. cfg"
Dat aFi | e2 = "FADATAL. dat "
ConfigFile2 = "STM32F4. cfg"

Example 3: Using multiple Batch sections with Flasher Portable.

Example scenario: 2 Devices in a JTAG chain, a STM32F1 and a STM32F4.
Selection 1 will program the STM32F1 target.

Selection 2 will program the STM32F4 target using "F4DATAO.dat".
Selection 3 will program the STM32F4 target using "F4DATA1.dat".
Selection 4 will execute 1, 2 and 3 in sequence.

e Exemplary content of FLASHER.INI:

[ BATCH|

Dat aFi | e = "F1DATA. dat "
ConfigFile = "STMB2F1. cfg"
[ BATCHL]

Dat aFi | e = "F4DATAO. dat "
ConfigFile = "STMB2F4. cf g"
[ BATCH2]

Dat aFi | e = "F4DATAL. dat "
ConfigFile = "STMB2F4. cf g"
[ BATCH3]

Dat aFi | e = "F1DATA. dat "
ConfigFile = "STMB2F1. cfg"
Dat aFi | el = "F4DATAO. dat "
ConfigFilel = "STMB2F4. cfg"
Dat aFi | e2 = "F4ADATAL. dat "
ConfigFile2 = "STMB2F4. cfg"
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2.12 Serial number programming

Flasher supports programming of serial numbers. In order to use the serial number pro-
gramming feature, the J-Flash project to be used as well as some files on the Flasher (de-
pending on the configuration) need to be configured first.

In general, Flasher supports two ways of programming a serial humber into the target:

1. Programming continuous serial numbers. Serial number is 1-4 bytes in size. Start serial
number, increment, serial number size and address is configured in the J-Flash project.

2. Programming custom serial numbers from a serial number list file. Start line into serial
number list file to get next serial number bytes, line increment, serial number size and
address is configured in J-Flash project. Serial number list file needs to be specified
and created by user.

In the following some generic information how to setup Flasher & the J-Flash project for
serial number programming are given.
Note

Full serial number programming support has been introduced with V4.51d of the J-
Flash software and the Flasher firmware that comes with it.

Note

Currently, programming of serial numbers is only supported for stand-alone mode.
Future versions of J-Flash may also support serial number programming in PC-based
mode.

2.12.1 Serial number settings

In order to enable the programming of serial numbers in stand-alone mode, the J-Flash
project has to be configured to enable programming a serial number at a specific address.
This is done by enabling the Program serial number option as shown in the screenshot
and table below:

Delay before start 20 ms

¥ Pragram serial number

Address [08001000 Len |4
Mext SN | 1234567 Increment |1

Actions performed by “duta"

v Erase ’W
[w Program

v "erif CRC -
[ Secure chip

[~ Start application

QK | Cancel
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Setting Meaning

The address the serial number should be

Addr ess
programmed at.

The length of the serial number (in bytes)
which should be programmed.

If no serial number list file is given, J-Flash
allows to use a 1-4 byte serial number. In
case of 8 is selected as length, the seri-
al number and its complementary is pro-
grammed at the given address.

In case a serial number list file is given,
Flasher will take the serial number bytes
from the list file. If a serial number in the
list file does not define all bytes of Len ,
the remaining bytes are filled with 0s. No
complements etc. are added to the serial
number.

Len

In case no serial number list file is giv-
en, Next SN is next serial number which
should be programmed. The serial number
is always stored in little endian format in
the flash memory.

In case a serial number list file is given,
Next SN Next SN describes the line of the serial
number list file where to read the next
serial number bytes from. Flasher starts
counting with line 0, so in order to start
serial number programming with the first
line of the SNLi st .t xt, Next SN needs to
be set to 0.

Specifies how much Next SNis increment-
ed.

I ncrenent

2.12.2 Serial number file

When selecting File -> Download serial number file to Flasher, J-Flash will create a
Serial number file named as <JFl ashProj ect Name>_Seri al . t xt. This file is downloaded
as SERI AL. TXT on Flasher. The file is generated based on the serial number settings in
the J-Flash project and will contain the value defined by the Next SN option. The serial
number file can also be manually edited by the user, since the serial number is written
ASCII encoded in the SERI AL. TXT file.

2.12.3 Serial number list file

In order to program custom serial numbers which can not be covered by the standard serial
number scheme provided by J-Flash (e.g. when programming non-continuous serial num-
bers or having gaps between the serial numbers), a so called serial number list file needs to
be created by the user. When selecting File-> Download serial number file to Flasher,
J-Flash will look for a serial number list file named as <JFl ashPr oj ect Nane>_SNLi st . t xt
in the directory where the J-Flash project is located. This file is downloaded as SNLi st . t xt
on Flasher. The serial number list file needs to be created manually by the user and has
the following syntax:

e One serial number per line
e Each byte of the serial nhumber is described by two hexadecimal digits.

Example
A 8-byte serial number should be programmed at address 0x08000000.
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It should be programmed as follows in the memory:

CHAPTER 2

Serial number programming

0x08000000: 0x01 0x02 0x03 0x04 Ox55 0Ox66 Ox77 0x88

The serial number list file should look as follows:
0102030455667788

File Edit Format View Help

0102030455667788
0102030455667789
010203045566778A
010203045566778B
010203045566778C
010203045566778D
010203045566778E
010203045566778F
0102030455667790
0102030455667791
0102030455667792
0102030455667793
0102030455667794
0102030455667795

The number of bytes to read per line is configured via the Len option in J-Flash. For more
information, please refer to Serial number settings on page 61.

Which line Flasher will read at the next programming cycle, is configured via the Next SN
option in J-Flash. For more information, please refer to Serial number settings on page 61.
In this case Next SN needs to be set to 0, since programming should be started with the
serial number bytes defined in the first line of the file.

Note

Flasher.

Note

2.12.4 Programming process

Flasher will increment the serial number in SERIAL.TXT by the value defined in | ncr enent
, after each successful programming cycle.

Flasher User Guide (UM08022)

If the number of bytes specified in a line of the serial number list file is less than
the serial number length defined in the project, the remaining bytes filled with 0s by

If the number of bytes specified in a line of the serial number list file is greater than
the serial number length defined in the J-Flash project, the remaining bytes will be
ignored by Flasher.

For each programming cycle, the FLASHER.LOG on the Flasher is updated and contains the
value from SERIAL.TXT that has been used for the programming cycle.

Note

The serial humber in SERIAL.TXT will also be incremented in case if serial number
programming is disabled, to make sure that for the Flasher logfile there is a reference
which programming cycle passed and which not. As long as serial number program-
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ming has not been enabled in the J-Flash project, Flasher does not merge any serial
number data into the image data to be programmed.

2.12.5 Downloading serial number files to Flasher

Downloading the serial number files needs to be done explicitly by selecting File-> Down-
load serial number file to Flasher. Please note that the File -> Download config &
data file to Flasher option does only download the configuration and data file to Flasher
since usually the current serial number used for programming shall not be reset/overwrit-
ten when just updating the image Flasher shall program.

2.12.6 Sample setup

In the following a small sample is given how to setup Flasher for serial number program-
ming. In the following sample, 4-byte serial numbers starting at 1234567 (0x12D687) shall
be programmed at address 0x08001000.

Defining serial number address, length and start value

In the J-Flash project the following needs to be defined:

Addr ess is 0x08001000
Next SNis 1234567

I ncrenent is 1

Len is 4 (bytes)

Delay befare start 20 ms

¥ Program serial number

Address [08001000 Len |4
Mest SH | 1234567 Increment |1

Actions performed by “duta'

v Erase Sectars if not blark -
|v Program

v Yerify CRC

™ Secure chip

[~ Start application

OK | Cancel
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Downloading configuration, data and serial number to Flasher.

After setting up the rest of the configuration (Target interface etc.) and selecting an appro-
priate data file, the configuration, data and serial number file is downloaded into Flasher
via the File -> Download config & data file to Flasher and File-> Download serial
number file to Flasher option.

Edit View Target Options Window Help

LA Cut-0 EINumberTest\Test.mot = e =

Merge data file...
w1 w2 wd
Save data file Ctrl+S |— J J

S T |1 |2]3/als|e[?|8|9 n|B|c|D|E|F[ascII [a
& 00 0P BP PL OO OO OO0 B2 0D DD OO B3 00 0@ OO ................ ]

0P PP AP PS PO PO A0 A6 AP BP OO BY 00 O OO .. ..............

0P PP AP P? P A A0 AN AP BP 0P OB 0@ 0@ OO ................

8P AP AP BD P P A@ AE AP BP 0P OF 0@ 0@ @A ................

6P PP AP 11 PP AP GO 12 AP B OB 13 0@ 6@ @A ................

6P AP AP 15 GA PA GO 16 G0 BA OA 17 0@ 0@ @@ ................

00 9P BP 19 OO OO OO0 1A OO OO OO 1B 0@ 0@ OO ................

99 PP PP 1D @A 9@ A 1F AP @0 0@ 1F PO VA 8O ...

0P AP AP 21 GA A A0 22 AP OO 0@ 23 0@ OO A0

0P PP AP 25 AR A PO 26 G0 B0 0@ 27 PO BB AA ..

0P PP BP 29 GA A A0 20 GD BP 0@ 2B GA @A BB <...)>.

6P BB AP 2D A @A A0 2E G0 GO 0@ 2F 0@ @A A6 ,...—. ..

New project
Opgen project...
Save project

Save project as...

Close project

Save Flasher config file...

o
+
I
3
T

I3 ol R

BT R RTR e R s R R TR TR R

90 BP 31 OO OO 60 32 A0 OO OO 33 00 00 60 O...1...2 -
Download config & data file to Flasher B) @ BB 35 U@ BA BB 36 OGP OO BB 37 B0 A8 A8 4...5...6.
o) B PP 39 G @ PO 30 G0 B0 0@ 3B PP PO AO &.. L
Download serial number file to Flasher @) 8@ BA 3D 9@ BA A@ 2E AP A @@ 3F A @9 A8 < P B
0P BP 41 PA PR AB 42 AP BP OA 43 G@ @A @A B...H...B...C..
Export setup file... 6P BP AP 45 A A A 46 AB BA O 47 B@ 0@ @@ D...E...F...G... —
00 B9 B9 49 OO OO OO0 4 OO OO OO 4B 00 0@ 00 H...I...J...K...
Export MCU device list... 0P PP AP 4D P B O@ 4E AP BP OO 4F 00 0@ 08 L...M...N...0...
o 0P PP AP 51 P A A 52 AP AP OA 53 P@ 0@ @@ P...Q...R...5...
Export flash device list... G0 AA @@ 55 AA P@ B0 56 AP BA @A 57 B0 A B8 T...U...U...W._.
i GP PP AP 59 PA A GG SA AP BP OB SB G@ 6@ @@ X...Y...Z...[...
Recent Files 4 6@ 90 B 5D P BP PO SE W0 O BB SF B0 08 B0 \...]...A..._..._:J
Recent Projects 3
. o || B ER
E AleFE b sl .

- New project created successfully

Saving project file [C:\Word'JLink ARM \Output\DebugDefault flash] ...

- Project saved successfully

Close project

- Project closed

Opening project file [C:\Temp“SeralNumberTest\STM32ZE_Test jflash] ...
- Project opened successfully

Opening data file [C:\Temp*SeralNumberTest\ Test mot] ...
- Data file opened successfulty (512 bytes, 1 range, CRC = leF31F28ET)

m

Download current configuration to programmer

After downloading the serial number to Flasher, J-Flash also created the <JFI ashPr oj ect -
Nane> Seri al . txt.

Share with + Mew folder

7

MName Date modified Type Size

STM3ITFE Tect iflach 25/06/201219:24 JFLASH File 3 KB
| STM32ZE_Test_Serial bt I 2 57 Text Document 1 KB
|| Test.mot 25/06/2012 19:32 MOT File 2 KB

Now Flasher is prepared to program the 8-byte serial number.
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2.13 Patch file support

In stand-alone mode Flasher supports patch files which allows to patch the content of the
data to be programmed. Patches for undefined memory locations will be ignored, so there
need to be placeholders in the data file. Before starting programming process in stand-alone
mode, Flasher will look for a file named Pat ches. t xt being present on the Flasher. This file
includes the patches. If this file is present, the number in Seri al . t xt describes the line
number of the Patches.txt that will be used for the current cycle (line counting starts at 0).

Each line in the Pat ches. t xt can hold up to 4 patches, where each patch can be up to
32 bytes in length.

Syntax

Each line begins with <NunPat ches> followed by each patch <Addr >, <NunByt es>: <Dat a>
in sequence and separated by commas. So the syntax for <NunPat ches> = = 4 would be
as follows:

<NurPat ches>, <Addr >, <NunByt es>: <Dat a>, <Addr >, <NunByt es>: <Dat a>, <Addr >,
<NumByt es>: <Dat a>, <Addr >, <NunByt es>: <Dat a>\r\n

Find below a table which describes each parameter.

Parameter Description

Describes the number of patches in this patch line. Max. val-

<NunPat ches> ;i
ue is 4.

Describes the address to be patched. Value is expected in

<Addr > hex
<NUBVt e > Number of bytes for the current patch. Max. value is 20h (32
y in decimal). Value is expected in hex.
<Dat a> Describes the data to be patched. <Data> is always expect-
ed as 2 hexadecimal characters per byte.
Note

All values are expected in hexadecimal format (hex).
<Data> section is always preceded by “:”, not *,".

Example

Below is an example patch.

1,18, 4:01020304\r\ n

Patching the following data:

00000000 Of 00 00 ER FE FF FF ER FE FF FF ER FE FF FF ELX ... &bivébivébive
00000010 FE FF FF ER O 00 00 94 FE FF FF EA FE FF FF EX  bidé....bHrebiye
00000020 00 €0 Z0 E3 01 70 87 E2 0l €0 56 E2 FD FF FF EX . _E.p.4.° . A70¢é

with the example patch will result in the following data:

Q0000000 0O 00 00 ER FE FF FF EA FE FF FF EA FE FF FF EE . ..&pbivebivébive
00000010 FE FF FF EA 0 00 00 94 [OL 02 02 Q4] FE FF FF ER bidé........ b
00000020 00 €0 R0 E3 01 70 87 E2 0l €0 S€ E2 FD FF FF ER . °_&.p.4.° . AT¥§e
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Please note that as mentioned earlier patching undefined memory locations will be ignored.
Applying the example patch to the following data:

00000000 00 00 00 00 0L 00 00 00 02 00 00 00 0% 00 00 90 ...
DO0000LD == —= == == == == —— = —— o —— o ..
00000020 00 00 00 00 01l 00 00 00 02 00 00 00 03 00 00 00 ... ...o...o.....

Causes no data to be patched, as can be seen in the following image:

00000000 00 00 00 00 01 00 00 00 02 00 00 00 03 00 00 00 ... ...
00000010 —= — = = <= —= = — [ommmee] s = - — ...

QooQoooza 00 00 00 00 01l 00 90 00 02 00 00 00 03 00 00 00 ... ...o.-

Therefore it is necessary to first write placeholder data to the memory locations which are
supposed to be patched.
An example for such a placeholder can be seen here:

0oo0oooD 00 00 00 00 01 00 00 00 02 00 00 00 03 00 00 00 ... ...

00000010 -— —-= == —— == —— —— —— |FF FF FF FE|-— —— —— —— ...._... G- - - -
00000020 00 00 00 00 01l 00 00 00 0Z 00 00 00 0% 00 00 00 .. .ooo.oo.....

Please note that the actual data inside the placeholder does not matter to the Flasher,
because it is overwritten during patching.
Applying the example patch will now work as expected:

QOoooooo 00 00 90 00 Ol 00 Q0 00 Q2 00 00 00 03 00 00 00 ... ... ...
aooogola — -— —— —— —-— —— —— —— {01 02 03 04— —— —— —— -
Qoooooza 00 00 00 00 01 90 00 00 02 00 00 00 02 00 00 00 ... ....o.-

Single patch via RS232

Alternatively, you can start a programming cycle with patch data that is only valid for this
one cycle (no need for a Patches.txt file):

Send the #AUTO PATCH <NunPat ches>, <Addr >, <NunByt es>: <Dat a>

command via Flasher ASCII interface. The parameters have the same function as described
in the table above.

2.13.1 Newline encoding

In general, for all patch files, init files etc. Flasher supports both newline encodings:

e Windows: \r\n
e Unix/Mac: \n

All parser functionality etc. are written to be independent from the host operating system.
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2.14 Limiting the number of programming cycles

Flasher provides a mechanism to limit the number of programming cycles that can be
performed in stand-alone mode with the configuration that is stored on the Flasher. To
make use of this feature, a file called Cnt down. t xt needs to be placed on the Flasher. This
file simply contains a decimal number (32-bit unsigned integer) that describes how many
programming cycles can be performed with the current setup.

This feature especially makes sense when used in combination with authorized flashing.
For more information about authorized flashing, please refer to Authorized flashing on
page 69.

Note

The number in the Cnt down. t xt is only updated on a successful programming cycle.
Programming cycles that failed, do not affect the Cnt down. t xt .

2.14.1 Changed fail/error LED indicator behavior

In case a Cnt down. t xt is found at boot time, the fail/error LED of Flasher behaves different
from normal. If the number of programming cycles left is 10 or below, the following will
happen:

e The red error/fail LED will lit for 1 second
e After this, it will blink/toggle x times @ 5 Hz, indicating the number of programming
cycles left. (blinking 5 times for 5 cycles left, ...)

2.14.2 Required Flasher hardware version for Cntdown.txt
support

Older Flasher models do not support the limiting of programming cycles. The Flashers with
the following serial humber ranges do not support limiting of programming cycles:

1621xxxxx (Flasher ARM V2)
1630xxxxx (Flasher ARM V3)
4210xxxxx (Flasher PPC V1)
4110xxxxx (Flasher RX V1)

All other models / hardware versions support limiting of programming cycles.
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2.15 Authorized flashing

Current hardware versions of Flasher support creation of a so called secure area which
allows to pre-configure the Flasher with a given setup and then give it to external production
facilities etc. without the possibility to read out the Flasher contents via file access mode,
FILE I/O functionality (J-Link Commander) or RS232 commands. This section describes how
to setup a secur e area on a Flasher and how to move the configuration/data file(s) into it.

2.15.1 Creating / Adding the secure area

By default, Flashers are shipped with a public area only (full Flasher flash size accessible
via file access mode etc.). The secure area has to be activated / created once, to make
use of it. This will reserve half of the Flasher storage size (on current models this will be
~64 MB) for the secur e area. The secure area can be removed at any time, providing the
full flasher storage to the public area again. The secure area can be created / removed
via J-Link Commander, which is part of the software package that comes with Flasher.

The following secure area related commands are available in J-Link Commander:

e Securearea create
® Securearea remove

Note

When creating or removing the secure area, all configuration and data files being
stored on the Flasher, are lost. Please make sure that they are not needed anymore,
before adding / removing the security area.

2.15.2 Moving files to the secure area

Before moving configuration + data to the secure area, proper functionality of the setup
should be tested in stand-alone mode. Once the setup is working as expected, do the
following, to move the configuration + data into the secure area:

e Start Flasher in file access mode (For more info, please refer to: file access mode on

o | =] &=
@.uv\_ » Computer » Removable Disk (E) + [ 4] [ Search Removable Disk (€ 2]
File Edit View Tools Help
Organize v Share with = New folder =~ 0l @
i Favorites - MName Date modified Type Size
B Desktop | Cntdown.txt 15-02-05 9:3. TXT File 1KB
& Downloads =] FLASHER.cfg 17:51 CFG File 2K8
& Recent Places &) FLASHER.dat 15-02-0317:51 DAT File 10 KB
= Libraries
| Documents
o Music
=] Pictures
Subversion
B® videos
M Computer
&, Local Disk (C)
e Removable Disk (E:)
3 items
-

e Create a folder *_SECURE"
e Move all files that shall be moved to the secure area, into this folder
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(E=8 =R =
@@v\_ » Computer ¢ Removable Disk (E) » ~ |42 |[ Search Removable Disk (£ 2|
File Edit View Tools Help
Organize v Share with = New folder =~ 0l @
B Desktop ~ Neme Date modified Type »
& Downloads Cnen
_SECURE 15-02-05 10:22 File folder
% Recent Places
=4 Libraries
| Documents
& Music
= Pict
Subversion
ﬂ Videos
8 Computer
&, Local Disk (C:)
e Removable Disk (E:)
_SECURE
1 tem
_—

Reboot Flasher (Do not enter file access mode again, yet! Otherwise, contents will not
be moved). Now, depending on the configuration and data file size, it may take a bit,
before the Flasher Power LED lit. Once it lit, all contents have been moved to the secur e
ar ea and the _SECURE folder in the public area has been deleted.

Now Flasher can be used in stand-alone mode, as normal, but the files cannot be read
back by the user / operator.

2.15.3 Considerations to be taken when using the secure

area

When using the secure area, some things need to be considered:

All features like multiple file support, patch file support etc. can also be used when
operating from the secure area.

The secur e area cannot be read back by any utility. Solely the FLASHER. LOG is always
placed and updated in the public area, even when Flasher operates from the secure
ar ea.

If there is any file/folder in the public area, except the FLASHER. LOGand there is also any
configuration / data present in the secur e ar ea, stand-alone flashing will fail because it
is not unambiguous which configuration / data shall be used. In such cases, Flashers with
Ethernet / RS232 interface will output an appropriate error message on programming.
All Flasher models will output an appropriate error message in the FLASHER. LOG.
Moving files from the public into the secure area can be done multiple times, as explained
in Moving files to the secure area on page 69. Each time files are moved from the
public area to the secure area, all contents of the secure area are erased first, to
make sure that no previous configuration is present there.

2.15.4 Required Flasher hardware version

Older Flasher models do not support authorized flashing. The Flashers with the following
serial number ranges do not support authorized flashing:

1621xxxxx (Flasher ARM V2)
1630xxxxx (Flasher ARM V3)
4210xxxxx (Flasher PPC V1)
4110xxxxx (Flasher RX V1)

All other models / hardware versions support authorized flashing.

Flasher User Guide (UM08022)

© 2004-2021 SEGGER Microcontroller GmbH



71

CHAPTER 2

2.16 Target interfaces

The table below shows the supported target interfaces of the different Flasher models.

Target interfaces

Hardware Supported interfaces
Flasher PRO JTAG, SWD
Flasher Compact JTAG, SWD
Flasher ARM JTAG, SWD
Flasher RX JTAG
Flasher PPC JTAG

For more information about the target interfaces itself, please refer to:

e UMO08001, chapter "Working with J-Link and J-Trace”, section "JTAG interface”
e UMO08001, chapter "Working with J-Link and J-Trace”, section "SWD interface”
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2.17 Supported architectures

Flasher supports programming of the internal flash of a large humber of different micro-
controllers. The number of supported devices is steadily growing. You can always find the
latest list of supported devices on our website:

http://www.segger.com/supported-devices.htm/

Sometimes, especially early in MCU development, only a few samples/boards are available
and may not be made available to third parties (e.g. SEGGER) to add support for a new
device. Also the existence of the device may have confidential status, so it might not be
mentioned as being supported in public releases yet. Therefore it might be desirable to be
able to add support for new devices on your own, without depending on SEGGER and a new
release of the J-Link Software an Documentation Pack being available.

The J-Link DLL allows customers to add support for new devices on their own. It is also
possible to edit / extend existing device support by for example adding new flash banks (e.g.
to add support for internal EEPROM programming or SPIFI programming). The following
article in our Wiki https://wiki.segger.com/Open_Flashloader explains how new devices can
be added to the DLL and how existing ones can be edited / extended.

If a device is not supported, you can always contact us. We will be happy to provide you
with an offer.

2.17.1 External flashes

In general our Flashers support programming of external flashes listed below:

parallel NOR flash

serial NOR flash

NAND flash

12C/(Q)SPI EEPROM/Flash
FRAM

If the parallel NOR flash device which is used is not CFI-compliant you have to select
the flash device in J-Flash explicitly, for a list of all parallel NOR flash devices which can
be explicitly selected in J-Flash, please refer to UM08003, J-Flash User Guide, chapter
Supported Flash Devices.

Since the connection of the flash to the CPU can be different for each of the other flash
types mentioned above, a suitable Open Flashloader can be used in such a case. The J-Flash
software comes with sample projects for Open Flashloader. For a complete list of all Open
Flashloader projects for use with J-Flash software, see also: http://www.segger.com/sup-
ported-devices.html

Note

Complete Information about Open Flashloaders can be found in our Wiki:
https://wiki.segger.com/Open_Flashloader

2.17.2 Cores

2.17.2.1 Flasher ARM

Flasher ARM supports and has been tested with the following cores, but should work with
any ARM7/9, Cortex-M0/M1/M3/M4 core. If you experience problems with a particular core,
do not hesitate to contact Segger.

ARM7TDMI (Rev 1)
ARM7TDMI (Rev 3)
ARM7TDMI-S (Rev 4)
ARM920T

ARM922T

Flasher User Guide (UM08022) © 2004-2021 SEGGER Microcontroller GmbH



73 CHAPTER 2 Supported architectures

ARM926EJ]-S
ARM946E-S
ARM966E-S
Cortex-MO
Cortex-M1
Cortex-M3
Cortex-M4

2.17.2.2 Flasher RX

Flasher RX supports and has been tested with the following cores. If you experience prob-
lems with a particular core, do not hesitate to contact Segger.

RX610
RX621
RX62N
RX62T

2.17.2.3 Flasher PPC

Flasher PPC supports and has been tested with the following cores. If you experience prob-
lems with a particular core, do not hesitate to contact Segger.

e e200z0

2.17.2.4 Flasher PRO/Compact/Portable PLUS

All of the above cores using J-Flash. Many more and constantly growing by means of Uni-
versal Flash Loader https://www.segger.com/supported-devices/flasher/.
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2.18 Programming multiple targets in parallel

To program multiple targets in parallel there are the following possibilities:

e Using a Flasher gang, or
e Using multiple Flashers, each connecting to one CPU.

Devices for gang progamming are:

e Flasher ATE; suitable for programming up to 10 targets in parallel. Refer Flasher ATE
user manual (UM08035_FlasherATE.pdf).

e Flasher Hub in conjunction with up to 24 Flasher (Compact). Refer Flasher Hub user
manual (UM08039_FlasherHUB.pdf).

When using multiple flashers, this can be done with the J-Flash production program-
ming software. For further information, please refer to Chapter “Command Line Inter-
face” Sub-chapter “Programming multiple targets in parallel” of the J-Flash User Guide
(UM08003_JFlash.pdf) which is part of the Flasher Software and Documentation package.
https://www.segger.com/downloads/flasher/#FlasherSoftwareAndDocumentationPack

Flasher User Guide (UM08022) © 2004-2021 SEGGER Microcontroller GmbH



75 CHAPTER 2 Logfiles and Quality Management

2.19 Logfiles and Quality Management

All Flasher models keep a log file named Fl asher. | og which logs each programming at-
tempt. This file contains the serial number of the device, the result of the programming
attempt, and the programming duration for quality tracking purposes. An example of a
Fl asher. | og file might look like the following:

SN. 1 - Failed
SN. 1 - Failed
SN 2 - OK (931 ns)
SN 3 - OK (931 ns)
SN 4 - OK (933 ns)
SN 5 - OK (932 ns)

If applicable, the logfile contains more detailed error messages. For example:

ERROR: Programming failed @address 0x00000000 (1)
ERROR: Cannot connect to CPU. Target interface speed too high?

The Flasher Portable PLUS creates an additional log file named UNI ERROR. LOG for Universal
Flash Loader projects. This file contains error messages that would otherwise have been
displayed by the other flashers on the terminal. For example:

Verify error config word area @
config word

config word read back

Verify error flash area @

data fromfile

data read back

Note

These log files can be accessed by booting the flasher into file access mode or directly
via FTP if the flasher has an appropriate network interface.
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TCP Services

This chapter describes the integrated TCP services.
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3.1 FTP Server

The FTP server provides easy access to the files on the internal file system. The server
supports a maximum of 2 simultaneous connections and works with all common FTP clients.

3.1.1 Access data

Anonymous access to the FTP server is limited to read-only access to the file system.
For write access, special login credentials have to be used:

Logi n: adnin

Password: 1234

Note

The access data for read/write access can not be modified and it is intended to be
used only as a convenience feature to avoid unintended modification of the Flasher’s
file system. It is not meant as a security feature.
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3.2 Web server

All Flashers which come with an Ethernet interface also come with a built-in web server,
which provides a web interface for information and network configuration. For the network,
the IP address settings can be changed and a nick hame can be assigned to the device.

Additionally, the web interface provides information about the status of the integrated op-
erating system, the IP stack and the target hardware.
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Remote control

This chapter describes how to control Flasher via the 9-pin serial interface connector or via
the integrated Telnet interface.
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4.1 Overview

There are 3 ways to control Flasher operation:
e Manual: Programming operation starts when pressing the button. The LEDs serve as

visible indicators.

e Via Handshake lines: 3 lines on the serial interface are used:
1 line is an input and can be used to start operation,
2 lines are outputs and serve as busy and status signals.
Terminal communication via RS232.
Terminal communication via Telnet.

Note

All ways to control Flasher operation are working only if Flasher is in standalone mode.
In PC-based mode or file access mode they have no effect.
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CHAPTER 4 Handshake control

Some Flasher models can be remote controlled by automated testers without the need
of a connection to a PC. Therefore Flasher is equipped with additional hardware control
functions, which are connected to the SUBD9 male connector, normally used as RS232

interface to PC.

The handshake control is available for the following Flashers:

e Flasher ARM
e Flasher PRO

e Flasher Compact (via Flasher Hub only)

The following diagrams show the internal remote control circuitry of Flasher:

~ o} 7‘7
4  BUSY r=n1
o ° 1 470 |
Ool]7 OK =71
°— 470 Flasher
° . .
ol1 START 5ok ] E internal Logic
—{ax7 | »—g
START D
BUSY
BUSY D
Ready
. Not OK
] Undefined f i
OK previous state > e valid
- oK
Pin No. Function Description
A positive pulse of any voltage between 5 and 30V
with duration of min. 30 ms starts “Auto” function
1 START (Clear / Program / Verify) on falling edge of pulse.
The behavior of the “Auto” function depends on the
project settings, chosen in J-Flash at the Produc-
tion tab.
As soon as the “Auto” function is started, BUSY
4 BUSY becomes active, which means that transistor is
switched OFF.
5 GND Common Signal ground.
This output reflects result of last action. It is valid
7 OK after BUSY turned back to passive state. The output
transistor is switched ON to reflect OK state.
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4.3 ASCIl command interface

4.3.1 Introduction

Once set up using J-Flash, the Flasher can be driven by any application or just a simple
terminal using ASCII commands.

Every known command is acknowledged by the Flasher and then executed. After command
execution, Flasher sends an ASCII reply message.

Note

There are situations where the execution of a known command is rejected with
#NACK:ERRxxx if Flasher is currently busy and the received command is not allowed
to be sent while Flasher is busy

4.3.2 General command and reply message format

e Any ASCII command has to start with the start delimiter #.
Any ASCII command has to end with simple carriage return (‘\r/, ASCII code 13).
Commands can be sent upper or lower case

4.3.3 General usage

Reply messages must be considered in each case. In general, a new command must not
be sent before a reply for the last one has been received.

When a flash programming function (#AUTO, #CANCEL, #ERASE, #PROGRAM #VERI FY) has
finished, the debug logic of the MCU is disabled (power down) and the target interface of
the module is switched off (tristated).

4.3.4 Settings for ASCII interface via RS232

Flasher is driven via a RS232 serial port with the following interface settings:

9600 baud
8 data bits
no parity
1 stop bit

The baud rate can be changed by using the #BAUDRATE command.

4.3.5 Settings for ASCII interface via Telnet

A client application can connect to Flasher via Telnet on port 23. Find below a screenshot
of Flasher which is remote controlled via Telnet:
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B Telnet 192.168.11.41 = o[

WJ-Link ARM ~ Flasher ARBM U3 telnet—shell.

WJ—-Link ARM ~ Flasher ARM U3 compiled Jan 29 2813 17:58:37
Fauto

HACK

HSTATUS : INITIALIZING

HSTATUS : CONNECTING

HSTATUS : UNLOCKING

HSTATUS : ERASING

HSTATUS : PROGRAMMING

HSTATUS :WVERIFY ING

HOK <(Total 7.797s. Erase B.884s, Prog 3.94%s. Uerify B.887s)

4.3.6 Commands and replies

The table below gives an overview about the commands which are supported by the current
version of Flasher firmware. Click on the names for a detailed description:

Commands to the Flasher

#BAUDRATE<Baudr at e>
#AUTO

#AUTO PATCH

#AUTO NO NFO
#CANCEL

#ERASE

#PROGRAM

#RESULT

#SELECT <Fi | enane>
#START

#STATUS

#VERI FY

File I/O commands

#FCLOSE

#FCRC

#FDELETE <Fi | enanme>

#FOPEN <Fi | enane>

#FREAD <O f set >, <NunByt es>

#FSI ZE

#FWRI TE <O f set >, <NunByt es>: <Dat a>
#FLI ST

#WKDI R <Di r nane>

SecureArea commands

#HASSECUREAREA
#SECUREAREA <acti on>

Replies from the Flasher

#ACK
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Commands to the Flasher

#NACK

#OK

#OK: <NunByt es>: <Dat a>
#OK: <Si ze>

#STATUS:

#DONE

#ERRX XX
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4.3.6.1 Commands to the Flasher

#AUTO

The #AUTO command behaves exactly as the start button or external remote control input.
Usually, the following command sequence will be performed when receiving the #AUTO
command:

e The Flasher erases the target CPU (if not blank)
e The Flasher programs the target CPU
e The Flasher verifies the target CPU

Depending on the settings chosen in the Production tab in J-Flash, this sequence can differ
from the one shown above.

Finally, Flasher responds with

e #OKif no error occurred

e #ERRxxx if any error occurred during operation. xxx represents the error code, normally
replied to Flasher PC program. The #ERRxxx message may be followed by an additional
error text.

During execution of the #AUTO command, Flasher automatically sends “status” messages
via RS232 to reflect the state of execution. Typically during execution of #AUTO command,
Flasher will reply the following sequence of messages:

#ACK

#STATUS: | NI TI ALI ZI NG

#STATUS: CONNECTI NG

#STATUS: UNLOCKI NG

#STATUS: ERASI NG

#STATUS: PROGRAMM NG

#STATUS: VERI FYI NG

#OK (Total 13.993s, Erase 0.483s, Prog 9.183s, Verify 2.514s)

#AUTO PATCH
The #AUTO PATCH command allows patching of the content of the data to be programmed.

Flasher responds with

e #OK if no error occurred

e #ERRxxx if any error occurred during operation. xxx represents the error code, normally
replied to Flasher PC program. The #ERRxxx message may be followed by an additional
error text.

For further information about the usage of the #AUTO PATCH command please refer to Patch
file support on page 66.

#AUTO NOINFO

This command may be used instead of #AUTQO, if no status messages from Flasher should
be sent during execution. The NOINFO extension is also available for all other commands.

The command ends with #OK or #ERRxxX

#BAUDRATE<Baudrate>

This command can be sent in order to change the baud rate of the Flasher’'s RS232 interface
used for communication. <Baudr at e> is expected in decimal format.

If this command succeeds, Flasher responds with:

#ACK
#OK

Otherwise it will respond with one of the following error messages:
#ERR255: | nvalid paraneters
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or
#ERR255: Baudrate is not supported

Note

After sending the #BAUDRATE command you will first have to wait until the Flasher
responds with the #OK message. It is recommended wait 5ms before sending the next
command with the new baudrate in order to give the Flasher the time to change the
baudrate.

#CANCEL

This command can be sent to abort a running program. It may take a while until the current
program is actually canceled.

Flasher will respond with:
#ERROO7: CANCELED.

#ERASE
This command can be sent to erase all selected target flash sectors.
Flasher will reply the following sequence of messages:

#ACK

#STATUS: | NI TI ALI ZI NG

#STATUS: CONNECTI NG

#STATUS: UNLOCKI NG

#STATUS: ERASI NG

#OK (Total 0.893s, Erase 0.483s)

#PROGRAM

This command can be used instead of #AUTOto program a target without erasing the target
before programming and without performing a final verification.

#RESULT

This command can be sent any time, even during other command execution. Flasher re-
sponds with the last result of the previously executed command.

#SELECT <Filename>

The #SELECT command is used to select a specific config and data file pair which should be
used by Flasher to program the target. <Fi | enane> specifies the name of file pair without
extensions (.CFG and .DAT) on the Flasher which should be selected. Flasher saves the
selected config and data file in the FLASHER.INI file. So this selection is remembered even
between power-cycling Flasher.

This may be verfy helpful in cases where several config and data files are stored on Flasher.
The user can easily switch between these config and data files without connecting Flasher
to a host.

If this command succeeds, Flasher responds with:

#ACK
#OK

Find below a sample sequence which shows how to use the #SELECT command:

#SELECT ATSAM/_1 // ATSAM7_1.CFG and ATSAM7_1.DAT is sel ected
#ACK

#OK

#AUTO // Start auto progranmi ng

#ACK

#STATUS: | NI TI ALI ZI NG
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#STATUS: CONNECTI NG

#STATUS: UNLOCKI NG

#STATUS: ERASI NG

#STATUS: PROGRAMM NG

#STATUS: VERI FYI NG

#OK (Total 8.416s, Erase 0.005s, Prog 6.845s, Verify 0.959s)
#SELECT ATSAM/_2 // ATSAM7_2. CFG and ATSAM7_2. DAT is sel ected
#ACK

#OK

#AUTO // Start auto progranm ng

#ACK

#STATUS: | NI TI ALI ZI NG

#STATUS: CONNECTI NG

#STATUS: UNLOCKI NG

#STATUS: ERASI NG

#STATUS: PROGRAMM NG

#STATUS: VERI FYI NG

#OK (Total 8.632s, Erase 0.005s, Prog 7.051s, Verify 0.969s)

#START

This command can be sent to start the application using the method configured in the J-
Flash project.

Flasher will reply with the following sequence of messages:

#ACK

#STATUS: | NI TI ALI ZI NG
#STATUS: CONNECTI NG
#OK (Total 1.148s)

#STATUS

This command can be sent any time, even during other command execution. Flasher re-
sponds with its current state. All defined state messages are described under Replies from
Flasher on page 91.

#VERIFY

This command can used to verify the target flash content against the data stored in Flasher.

4.3.6.2 File I/O commands

The ASCII interface of the Flasher also supports file I/O operations.

The following file I/O commands are supported:

#FCLOSE

The #FCLOSE command closes the file on Flasher which was opened via #FOPEN. After this
command has been issued further file I/O operations except #FDELETE are not allowed until
the #FOPEN command is send again.

A typical sequence when using the #FCLOSE command does look like as follows:

#FCLOSE
#ACK
#OK

Note

When using the #FCLOSE command a file has to be open (previously opened by
#FOPEN). Otherwise Flasher will respond with the following if no file has been opened:

#ACK
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#ERR255: No fil e opened

#FCRC

The #FCRC command calculates a 32-bit CRC of the given file. This CRC can be used to verify
file integrity. This command should not be used while a file has been opened via #FOPEN.
The CRC will be also reported by J-Flash when downloading or saving files via J-Flash.

A typical sequence when using the #FCRC command does look like as follows:

#FCRC f | asher. dat
#ACK
#OK: 0x75BC855A

#FDELETE <Filename>

The #FDELETE command is used to delete a file on Flasher where <Fi | enanme> specifies the
name of the file.

A typical sequence when using the #FDELETE command does look like as follows:

#FDELETE f| asher. dat
#ACK
#OK

Note
If deletion of the file fails for example if the file does not exist, Flasher will respond
with the following sequence:

#ACK
#ERR255: Fail ed to delete file

#FOPEN <Filename>

The #FOPEN command is used to open a file on Flasher for further file I/O operations.
<Fi | enane> specifies the file on the Flasher which should be opened. If <Fi | enane> can
not be found on Flasher a new one will be created.

A typical sequence using the #FOPEN command does look like as follows:

#FOPEN f | asher . dat
#ACK
#OK

Note
Currently only one file can be open at the same time. If #FOPEN is send and another
file is already open, Flasher will respond with:

#ACK
#ERR255: A fil e has al ready been opened

#FREAD <Offset>,<NumBytes>

The #FREAD command is used to read data from a file on Flasher. <O f set > specifies the
offset in the file, at which data reading is started. <NunByt es> specifies the number of bytes
which should be read.

A typical sequence when using the #FREAD command does look like as follows:

#FREAD 0, 4
#ACK
#OK: 04: 466¢6173
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If the #FREAD command succeeds, Flasher will finally respond with a #0K: <NunByt es>: <Da-
t a> reply message. For more information about the Flasher reply messages, please refer
to Replies from Flasher on page 91.

Note
In order to use the #FREAD command. A file has to be opened before, via the #FOPEN
command. Otherwise Flasher will respond with the following sequence:

#ACK
#ERR255: No fil e opened

#FSIZE
The #FSI ZE command is used to get the size of the currently opened file on Flasher.
A typical sequence when using the #FSI ZE command does look like as follows:

#FSI ZE
#ACK
#OK: 10 // file on flasher which is currently open, has a size of 16 bytes

If the #FSI ZE command succeeds, Flasher will respond with a #0K: <Si ze> reply message.
For more information about the Flasher reply messages, please refer to Replies from Flasher
on page 91.

Note
In order to use the #FREAD command. A file has to be opened before, via the #FOPEN
command. Otherwise Flasher will respond with the following sequence:

#ACK
#ERR255: No fil e opened

#FWRITE <Offset>,<NumBytes>:<Data>

The #FWRI TE command is used to write to a file on Flasher. <O f set > specifies the offset in
the file, at which data writing is started. <NunByt es> specifies the number of bytes which
are send with this command and which are written into the file on Flasher. <NunByt es>
is limited to 512 bytes at once. This means, if you want to write e.g. 1024 bytes, you
have to send the #FWRI TE command twice, using an appropriate offset when sending it
the second time.

<O f set > and <NunByt es> are expected in hexadecimal format.

#FWRI TE 0, 200: <Dat a>
#FWRI TE 200, 200: <Dat a>

The data is expected in hexadecimal format (two hexadecimal characters per byte). The
following example illustrates the use of #FWRI TE:

Data to be send: Hello !
ASCI | val ues: 0x48, 0x65, 0x6C, 0x6C, 0x6F, 0x20, 0x21

#FWRI TE 0, 7: 48656C6C6F2021

Note
In order to use the #FWRI TE command a file has to be opened via the #FOPEN command,
first. Otherwise Flasher will respond with the following sequence:

#ACK
#ERR255: No fil e opened
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#FLIST
The #LI ST command is used to list all files stored on the Flasher.
A typical sequence using the #FLI ST command does look like as follows:

#FLI ST
#ACK

FLASHER I NI Size: 60

SERI AL. TXT Size: 3

FLASHER. LOG Si ze: 207
FOLDER (DI R)

FOLDER\ TEST1. CFG Si ze: 2048
FOLDER\ TEST1. DAT Size: 12288
HOK

#MKDIR <Dirname>

The #MKDI R command is used to create a directory on Flasher. <Di r nane> specifies the
name of the new directory. <Di r nane> may also specify a path to create a subdirectory.

A typical sequence using the #MKDI R command does look like as follows:

#MKDI R f ol der
#ACK
#OK

Note
If the directory can not be created because of a bad <Di r nane> argument, Flasher
will respond with:

#ACK
#ERR255: Fail ed to create directory

4.3.6.3 Secure Area Commands

#HASSECUREAREA

The #HASSECUREAREA command checks if the Flasher is configured with a secure area.
#RESULT: YES indicates the secure area is present, #RESULT: NO indicates no secure area
is present.

#SECUREAREA

The #SECUREAREA <acti on> command allows to create or remove the secure area on the
Flasher.

e the action CREATE creates the secure area.

e the action REMOVE will remove the secure area.

A typical sequence using the #SECUREAREA command does look like as follows:

#SECUREAREA CREATE
#ACK
#DONE

Note

When creating or removing the secure area, all configuration and data files being
stored on the Flasher, are lost. Please make sure that they are not needed anymore,
before adding / removing the security area.
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4.3.6.4 Replies from Flasher

The reply messages from Flasher follow the same data format as commands. Any reply
message starts with ASCII start delimiter #, ends with simple carriage return (ASCII code
13) and is sent in uppercase. In contrast to commands, replies can be followed by a de-
scriptive message, which gives more detailed information about the reply. This description
is sent in mixed case. The #OK reply, for example, is such a reply. It is followed by a string
containing information about the performance time needed for the operations:

#OK (Total 13.993s, Erase 0.483s, Prog 9.183s, Verify 2.514s)

The following reply messages from Flasher are defined:

#ACK

Flasher replies with #ACK message on reception of any defined command before the com-
mand itself is executed.

#NACK

Flasher replies with #NACK, if an undefined command was received.

#OK

Flasher replies with #0OK, if a command other than #STATUS or #RESULT was executed and
ended with no error.

#OK:<NumBytes>:<Data>

Flasher replies with #OK: <Len>: <Dat a> if a #FREAD command was executed. <NunByt es>
is the number of bytes which could be read. This value may differ from the number of
requested bytes, for example if more bytes than available, were requested. <NunByt es>
and <Dat a> are send in hexadecimal format (for <Data>: two hexadecimal characters per
byte).

#OK:<Size>

Flasher replies if #0K: <Si ze> if a #FSI ZE command has been executed. <Si ze> is the size
(in bytes) of the currently opened file. <Si ze> is send in hexadecimal format.

#STATUS:
The Flasher replies with its current state.

The following status messages are currently defined:

Message Description
#STATUS: READY Flasher is ready to receive a new com-
mand.
#STATUS: CONNECT! NG (F:Islsfer initializes connection to target
HSTATUS: | NETIALL ZI NG ::rici—its.her performs self check and internal
#STATUS: UNLOCKI NG Unlocking flash sectors.
4STATUS: ERASI NG (I;I:\fir;:r is erasing the flash of the target

Flasher is programming the flash of the

#STATUS: PROGRAMM NG )
target device.

Flasher verifies the programmed flash con-

#STATUS: VERI FYI NG
tents.
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If any command other than #STATUS or #RESULT was terminated with an error, Flasher
cancels the command and replies with an error message instead of #0K message.

Some error codes may be followed by colon and an additional error text.

For example:

#ERROO7: CANCELED.

The error code numbers are described in the following table:

Message Description

#ERROO7 Flasher received #CANCEL comm_and and
has canceled the current operation.

#ERROOS FIasher is already busy with execution of
previous command.

#ERR0O09 Failed to allocate memory.

#ERRO10 Failed to open file.

#ERR011 Failed to read file.

#ERR012 Failed to write file.

#ERRO13 Failed to delete file.

#ERRO55 Undefined error occu_rred. This reply is fol-
lowed by an error string.
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Chapter 5

Performance

The following chapter lists programming performance of common flash devices andmicro-
controllers.
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5.1 Performance of MCUs with internal flash memory

5.1.1 Flasher ARM

The following table lists program and erase performance values of Flasher ARM for different

controllers.

Mieresemirelier | Se [IKEyE tinlqzéa[zic] uPrLZg[ZZ”S] tin\1/: r[g)éc] timTeOE::ac]
Analog Devices 62 2.943 2.286 0.563 5.792
ﬁggﬂ%wsm 64 _ 3.488 0.438 3.926
ﬁ'tl'rgfISAM75256 256 — 7.709 1.053 8.762
NXP LPC1768 512 3.740 8.559 5.092 17.391
NXP LPC2106 120 0.448 1.204 0.634 2.286
NXP LPC2129 248 0.449 2.916 1.347 4.712
NXP LPC2138 500 0.448 5.488 2.649 8.585
NXP LPC2148 500 0.448 5.632 2.721 8.801
NXP LPC2294 2048 0.808 15.976 9.669 26.453
NXP LPC2478 504 0.448 5.419 2.559 8.426
ST STM32F103ZE | 512 0.028 18.763 3.939 22.730
ST STR711 272 0.429 5.476 4.742 10.647
ST STR912 544 1.167 12.907 5.236 19.310
TI TMS470R1BIM | 1024 2.289 8.147 5.362 15.798

5.1.2 Flasher PRO
See Flasher ARM.

5.1.3 Flasher Compact

See Flasher ARM.

5.1.4 Flasher RX

The following table lists program and erase performance values of Flasher RX.

. : Erase Program Verify Total
g eretel g Sl [l time [sec] time [sec] time [sec] time [sec]
R5F56108 2.048 9.523 11.915 3.890 25.585

5.1.5 Flasher PPC

The following table lists program and erase performance values of Flasher PPC.

. : Erase Program Verify Total
g eretel g Sl [l time [sec] time [sec] time [sec] time [sec]
ST SPC560B50 576 4.747 4,159 1.929 10.917
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Chapter 6

Hardware

This chapter gives an overview about Flasher specific hardware details, such as the pinouts
and available adapters.
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6.1 Flasher ARM 20-pin JTAG/SWD Connector

Flasher has a JTAG connector compatible with ARM’s Multi-ICE. The JTAG connector is a
20 way Insulation Displacement Connector (IDC) keyed box header (2.54mm male) that
mates with IDC sockets mounted on a ribbon cable.

6.1.1 Pinout JTAG

VTref 1e o2 |Vsupply
nTRST 3 e ® 4 |GND
TDI 5e e 6 |GND
T™MS 7 e ® 8 |GND
TCK Qe e 10| GND
RTCK [11 ] ® 12| GND
TDO 13 ® 14| GND
RESET 15 ® 16| GND
DBGRQ 17 e ® 18| GND
V5-Supply |19 ¢ 20| GND

The following table lists the Flasher JTAG pinout.

PIN SIGNAL TYPE Description

This is the target reference voltage. It is used to check if the
target has power, to create the logic-level reference for the
1 | VTref Input | input comparators and to control the output logic levels to
the target. It is normally fed from Vdd of the target board
and must not have a series resistor.

This pin is not connected to Flasher ARM. It is reserved for
2 | Vsupply NC compatibility with other equipment. Connect to Vdd or leave
open in target system.

JTAG Reset. Output from Flasher ARM to the Reset signal of
the target JTAG port. Typically connected to nTRST of the
target CPU. This pin is normally pulled HIGH on the target to
avoid unintentional resets when there is no connection.

JTAG data input of target CPU. It is recommended that this
5 |TDI Output | pin is pulled to a defined state on the target board. Typically
connected to TDI of target CPU.

JTAG mode set input of target CPU. This pin should be pulled
up on the target. Typically connected to TMS of target CPU.

JTAG clock signal to target CPU. It is recommended that this
9 |TCK Output | pin is pulled to a defined state of the target board. Typically
connected to TCK of target CPU.

Return test clock signal from the target. Some targets must
synchronize the JTAG inputs to internal clocks. To assist in
meeting this requirement, you can use a returned, and re-
11 | RTCK Input | timed, TCK to dynamically control the TCK rate. Flasher ARM
supports adaptive clocking, which waits for TCK changes to
be echoed correctly before making further changes. Connect
to RTCK if available, otherwise to GND.

JTAG data output from target CPU. Typically connected to
TDO of target CPU.

Target CPU reset signal. Typically connected to the RESET
15 | RESET I/0 pin of the target CPU, which is typically called “*nRST”,
“nRESET"” or "RESET".

3 | nTRST Output

7 | TMS Output

13 | TDO Input
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PIN SIGNAL TYPE Description
This pin is not connected in Flasher ARM. It is reserved for
compatibility with other equipment to be used as a debug
171 DBGRQ NC request signal to the target system. Typically connected to
DBGRQ if available, otherwise left open.
5V-Target This pin is used to supply power to some eval boards. Typi-
19 Output
supply cally left open on target hardware.

Pins 4, 6, 8, 10, 12, 14, 16, 18, 20 are GND pins connected to GND in Flasher ARM. They
should also be connected to GND in the target system.

6.1.2 Pinout SWD

The 20-pin connector of Flasher is also compatible to ARM’s Serial Wire Debug (SWD)

interface.
VTref 1
Not used 3
Not used 5
SWDIO 7
SWCLK 9
Not used [ 11
SWO 13
RESET 15
Not used 17
V5-Supply [19

e 2
e 4
®0
e 8
e 10
e 12
® 14
® 16
® 18
® 20

Vsupply
GND
GND
GND
GND
GND
GND
GND
GND
GND

The following table lists the J-Link / J-Trace SWD pinout.

PIN

SIGNAL

TYPE

Description

VTref

Input

This is the target reference voltage. It is used to check if the
target has power, to create the logic-level reference for the
input comparators and to control the output logic levels to
the target. It is normally fed from Vdd of the target board
and must not have a series resistor.

Vsupply

NC

This pin is not connected in J-Link. It is reserved for compat-
ibility with other equipment. Connect to Vdd or leave open in
target system.

Not Used

NC

This pin is not used by J-Link. If the device may also be ac-
cessed via JTAG, this pin may be connected to nTRST, other-
wise leave open.

Not used

NC

This pin is not used by J-Link. If the device may also be ac-
cessed via JTAG, this pin may be connected to TDI, other-
wise leave open.

SWDIO

I/0

Single bi-directional data pin.

SWCLK

Output

Clock signal to target CPU.

It is recommended that this pin is pulled to a defined state
of the target board. Typically connected to TCK of target
CPU.

11

Not used

NC

This pin is not used by J-Link. This pin is not used by J-Link
when operating in SWD mode. If the device may also be ac-
cessed via JTAG, this pin may be connected to RTCK, other-
wise leave open.

13

SWO

Output

Serial Wire Output trace port. (Optional, not required for
SWD communication.)
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PIN SIGNAL TYPE Description
Target CPU reset signal. Typically connected to the RESET
15 | RESET I/0 pin of the target CPU, which is typically called “"nRST”",

“nRESET” or "RESET".

17 | Not used NC

This pin is not connected in J-Link.

19

5V-Target
supply

Output

This pin is used to supply power to some eval boards. Not all
J-Links supply power on this pin, only the KS (Kickstart) ver-
sions. Typically left open on target hardware.

Pins 4, 6, 8, 10, 12, 14, 16, 18, 20 are GND pins connected to GND in J-Link. They should
also be connected to GND in the target system.

6.1.3 Target power supply

Pin 19 of the connector can be used to supply power to the target hardware. Supply volt-
age is 5V, max. current is 400mA. The output current is monitored and protected against

overload and short-circuit.

Power can be controlled via the J-Link commander. The following commands are available
to control power:

Command Explanation
power on Switch target power on
power of f Switch target power off
power on perm Set target power supply default to “on”
power of f perm Set target power supply default to “off”
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6.2 Flasher RX 14-pin connector

Flasher RX itself has a 20-pin JTAG connector mounted but comes with a 14-pin adapter for
Renesas RX devices. This adapter also enables Flasher RX to optionally power the connected
target hardware. On the adapter there is a jumper which allows selection between 3.3V
and 5V supply target voltage supply. The target is supplied via the VTref connection when
the supply option is jumpered.

TCK

T
T

T
n

RSTn
DO

DI
RES

I

1 ee2 | GND
3 ee 4 | EMLE
5 6 |--

7 ©8 [ VTref
9e 10| ---

11 e® 12{ GND
13 ®® 14| GND

The following table lists the Flasher RX 14-pin JTAG pinout.

Pin

Signal

Type

Description

TCK

Output

JTAG clock signal to target CPU. It is recommended that this
pin is pulled to a defined state on the target board. Typically
connected to TCK on target CPU.

TRSTn

Output

JTAG Reset. Output from Flasher ARM to the Reset signal of
the target JTAG port. Typically connected to nTRST of the
target CPU. This pin is normally pulled HIGH on the target to
avoid unintentional resets when there is no connection.

EMLE

Output

Pin for the on-chip emulator enable signal. When the on-chip
emulator is used, this pin should be driven high. When not
used, it should be driven low. Pulled HIGH to VTref via 1k
pull-up resistor on 14-pin adapter.

TDO

Input

JTAG data output from target CPU. Typically connected to
TDO on target CPU.

NC

This pin is not connected to Flasher RX.

NC

This pin is not connected to Flasher RX.

VTref

Input

This is the target reference voltage. It is used to check if the
target has power, to create the logic-level reference for the
input comparators and to control the output logic levels to
the target. It is normally fed from Vdd of the target board
and must not have a series resistor.

TMS

Output

JTAG mode set input of target CPU. This pin should be pulled
up on the target. Typically connected to TMS on target CPU.

10

NC

This pin is not connected to Flasher RX.

11

TDI

Output

JTAG data input of target CPU. It is recommended that this
pin is pulled to a defined state on the target board. Typically
connected to TDI on target CPU.

13

nRES

I/0

Target CPU reset signal. Typically connected to the RESET
pin of the target CPU, which is typically called “*nRST”",
“NRESET"” or “"RESET".

All pins marked NC are not connected to Flasher RX. Any signal can be applied here;
Flasher RX will simply ignore such a signal.
Pins 2, 12, 14 are GND pins connected to GND in Flasher RX. They should also be
connected to GND in the target system.
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6.2.1 Target power supply

CHAPTER 6 Flasher RX 14-pin connector

Pin 8 of the 14-pin connector can be used to supply power to the target hardware. Supply
voltage is 3.3V / 5V, max. current is 400mA. The output current is monitored and protected
against overload and short-circuit. Power can be controlled via the J-Link commander. The
following commands are available to control power:

Command Explanation
power on Switch target power on
power of f Switch target power off
power on perm Set target power supply default to “on”
power of f perm Set target power supply default to “off”
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CHAPTER 6 Flasher PPC 14-pin connector

6.3 Flasher PPC 14-pin connector

Flasher PPC itself has a 20-pin JTAG connector mounted but comes with a 14-pin adapter
for PowerPC devices.

TDI

TDO

TCK |:
nRES

VDDE7?7 1
nRDY 13

H O N U1 W~

® 2 | GND
® 4 | GND
® 6 | GND
8 | ---
® 10| TMS
® 12| GND
® 14| JCOMP

The following table lists the Flasher PPC 14-pin JTAG pinout.

Pin Signal

Type Description

1 | TDI

JTAG data input of target CPU. It is recommended that this
Output | pin is pulled to a defined state on the target board. Typically
connected to TDI on target CPU.

3 |TDO

JTAG data output from target CPU. Typically connected to

InpUt | Tp0 on target CPU.

5 | TCK

JTAG clock signal to target CPU. It is recommended that this
Output | pin is pulled to a defined state on the target board. Typically
connected to TCK on target CPU.

NC This pin is not connected to Flasher PPC.

NC This pin is not connected to Flasher PPC.

9 | nRES

Target CPU reset signal. Typically connected to the RESET
I/0 pin of the target CPU, which is typically called “*nRST”,
“nRESET"” or "RESET".

10 | TMS

JTAG mode set input of target CPU. This pin should be pulled

Output up on the target. Typically connected to TMS on target CPU.

11 | VDDEY

This is the target reference voltage. It is used to check if the
target has power, to create the logic-level reference for the
Input |input comparators and to control the output logic levels to
the target. It is normally fed from Vdd of the target board
and must not have a series resistor.

13 | nRDY

Nexus ready output. Indicates to the development tools that
Input |the data is ready to be read from or written to the Nexus
read/write access registers.

14 | JCOMP

JTAG TAP Controller Enable / JTAG Compliancy (JCOMP).
JCOMP is used to enable the TAP controller for communica-
Output | tion to the JTAG state machine for boundary scan and for de-
bug access. This pin is set to HIGH by Flasher PPC (in order
to enable the JTAG TAP controller on the target device).

e All pins marked NC are not connected to Flasher PPC. Any signal can be applied here;
Flasher PPC will simply ignore such a signal.

e Pins 2, 12, 6, 12 are GND pins connected to GND in Flasher PPC. They should also be
connected to GND in the target system.
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6.4 Target board design

We strongly advise following the recommendations given by the chip manufacturer. These
recommendations are normally in line with the recommendations. Please refer to the the
appropriate tables depending on the core:

e Pinout JTAG on page 96

e Pinout SWD on page 97

e Flasher RX 14-pin connector on page 99

e Flasher PPC 14-pin connector on page 101

In case of doubt you should follow the recommendations given by the semiconductor man-
ufacturer.

6.4.1 Pull-up/pull-down resistors

Unless otherwise specified by developer’'s manual, pull-ups/pull-downs are recommended
to be between 2.2 kOhms and 47 kOhms.

6.4.2 RESET, nTRST

The debug logic is reset independently from the CPU core with nTRST. For the core to
operate correctly it is essential that both signals are asserted after power-up.

The advantage of having separate connection to the two reset signals is that it allows the
developer performing software debug to setup breakpoints, which are retained by the debug
logic even when the core is reset. (For example, at the reset vector address, to allow the
code to be single-stepped as soon as it comes out of reset). This can be particularly useful
when first trying to bring up a board with a new ASIC.
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6.5 Adapters

6.5.1 JTAG Isolator

The JTAG Isolator can be connected between Flasher and JTAG adapter, to provide electrical
isolation. This is essential when the development tools are not connected to the same
ground as the application. For more information about the JTAG Isolator, please refer to J-
Link JTAG Isolator User Manual (UM08010) which can be downloaded from our website.

CHAPTER 6 Adapters

VCC 1M m2(VCC
NTRST |3® B4 GND
TDI sH HMe |GND
TMS 7@ M8 GND
TCK om M10|GND
RTCK 11H M12(GND
TDO [13E Mi4GND
RESET |15H Ni6 GND
N/C 170 M18|GND
N/c 19 H20 GND
6.5.1.1 Pinout
The following table shows the target-side pinout of the J-Link JTAG Isolator.

Pin Signal Type Description

1 |VCC Output | The target side of the isolator draws power over this pin.

2 |VCC Output | The target side of the isolator draws power over this pin.
JTAG Reset. Output from Flasher to the Reset signal of the
target JTAG port. Typically connected to nTRST of the target

3 | nTRST Output CPU. This pin is normally pulled HIGH on the target to avoid
unintentional resets when there is no connection.

JTAG data input of target CPU. It is recommended that this

5 |TDI Output | pin is pulled to a defined state on the target board. Typically
connected to TDI of target CPU.

7 | TMs Output JTAG mode set input of target CPU. This pin should be pulled

P up on the target. Typically connected to TMS of target CPU.
JTAG clock signal to target CPU. It is recommended that this

9 |TCK Output | pin is pulled to a defined state of the target board. Typically
connected to TCK of target CPU.

Return test clock signal from the target. Some targets must

11 | RTCK Input synchronlz_e the J'!'AG inputs to internal clocks. To assist in
meeting this requirement, you can use a returned, and re-
timed, TCK to dynamically control the TCK rate.

JTAG data output from target CPU. Typically connected to

13700 Input TDO of target CPU.

Target CPU reset signal. Typically connected to the RESET

15 | RESET I/0 pin of the target CPU, which is typically called “*nRST”",
“NRESET"” or “"RESET".

17 | N/C N/C This pin is not connected on the target side of the isolator.

19 | N/C N/C This pin is not connected on the target side of the isolator.
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Pins 4, 6, 8, 10, 12, 14, 16, 18, 20 are connected to GND.

6.5.1.2 Safety

This isolator provides basic isolation only. Do not use with hazardous voltages with-
out further protection measures to avoid risk of electrical shock and fire.

SEGGER isolators provide a basic isolation to withstand high voltages as mentioned in
the resp. technical data section. To preserve integrity of human beings when dealing with
potential hazardous voltages it is mandatory to have a second protection measure in place
in case the first insulation barrier fails. This is called double or reinforced isolation. How this
double isolation can be achieved depends on the use case or application setup. Also check
your the local safety related directives valid for your country to make sure all requirements
are met.

6.5.2 J-Link Needle Adapter

To connect to the J-Link OB via programming interface the J-Link Needle Adapter is rec-
ommended.

Why to choose the J-Link Needle Adapter:

No additional connector required on your PCB

Very small footprint

High reliability spring pins for secure connections

Designed with 3 locating pins, so the adapter can not be connected the wrong way

No external power supply required! The J-Link Needle Adapter comes with the option
to power the target hardware via J-Link.

AN E

These features make the J-Link Needle Adapter the perfect solution for production purposes.

The pinout of the J-Link Needle Adapter is based on the pinout of the needle adapter by Tag-
Connect. Please note, that both pinouts are not identical since the J-Link Needle Adapter
comes with a 5V-supply pin.

As you can see on the image below, the three locating pins ensure, that the adapter cannot
be connected to the PCB the wrong way.

Moreover, the two “legs” on each side of the connector guarantee a stable and secure
contact between pins and the PCB.

Lacating -
Pins

Flasher User Guide (UM08022) © 2004-2021 SEGGER Microcontroller GmbH



105

VTref
SWDID/TMS
GMND
SWCLK/TCK
5V-Supply
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CHAPTER 6

nRESET
TRST

TDI

ETCK
SWO/TDO

Adapters

The J-Link Needle Adapter can be connected to J-Link via the 20-pin 0.1” JTAG to a 10-
pin needle connector.
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6.6 How to determine the hardware version

To determine the hardware version of your Flasher, the first step should be to look at the
label at the bottom side of the unit. Flasher has the hardware version printed on the back
label.

If this is not the case with your Flasher, you can use JLi nk. exe to determine your hardware
version (if Flasher is in PC-based mode). As part of the initial message, the hardware version
is displayed. For more information about how to ensure that Flasher is in PC-based mode,
please refer to PC-based mode on page 39.

Kl C\Program Files (86)\SEGGER\JLinkARM_V458a\Link.exe [r| =[]

REGGER J-Link Commander U4.58a ('?' for help>

Compiled Dec 5 2812 18:38:27

DLL version V4.58a. compiled Dec 5 2812 18:38:88

Firmuare: ﬂghaak ARM ~ Flasher ARM VU3 compiled MNov 28 2812 18:57:5%8

m|

: JFlash
: No configuration received via DHCP
UTarget = 3.267U
Info: TotallRLen = 4. IRPrint = BxB1
Found 1 JIAG device,., Total IRLen = 4:
#@ Id: 8x3FBFAFOF. IRLen: @4, IRPrint: Bx1, ARM?IDMI Core
Found ARM with core Id Bx3FBFBFBF <(ARM7?>

JTAG speed: 188 kHz
]J-Link>_
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Support and FAQs

This chapter contains troubleshooting tips together with solutions for common problems
which might occur when using Flasher. There are several steps you can take before con-
tacting support. Performing these steps can solve many problems and often eliminates the

need for assistance. This chapter also contains a collection of frequently asked questions
(FAQs) with answers.
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7.1 Contacting support

Before contacting support, make sure you tried to solve your problem by trying your Flasher
with another PC and if possible with another target system to see if it works there. If the
device functions correctly, the USB setup on the original machine or your target hardware
is the source of the problem, not Flasher.

If you need to contact support, send the following information to
support@segger.com

A detailed description of the problem

Flasher serial number

Information about your target hardware (processor, board, etc.).

FLASHER. CFG, FLASHER. DAT, FLASHER. LOG, SERI AL. TXT file from Flasher. To get these
files, Flasher has to be in file access mode. For more information about how to boot
Flasher in file access mode, please refer to file access mode on page 42.

Flasher is sold directly by SEGGER.
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7.2 Frequently Asked Questions

Maximum JTAG speed

Q: What is the maximum JTAG speed supported by Flasher?
A: Flasher’s maximum supported JTAG speed is 12MHz.

Maximum download speed

Q: What is the maximum download speed?

A: The maximum download speed is currently about 720 Kbytes/second when downloading
into RAM. The actual speed depends on various factors, such as JTAG, clock speed, host
CPU core etc.
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Chapter 8

Background information

This chapter provides background information about flash programming in general. It also
provides information about how to replace the firmware of Flasher manually.

Flasher User Guide (UM08022) © 2004-2021 SEGGER Microcontroller GmbH



111 CHAPTER 8 Flash programming

8.1 Flash programming

Flasher comes with a DLL, which allows - amongst other functionalities - reading and writing
RAM, CPU registers, starting and stopping the CPU, and setting breakpoints.

8.1.1 How does flash programming via Flasher work?

This requires extra code. This extra code typically downloads a program into the RAM of
the target system, which is able to erase and program the flash. This program is called
RAM code and “knows” how to program the flash; it contains an implementation of the
flash programming algorithm for the particular flash. Different flash chips have different
programming algorithms;the programming algorithm also depends on other things, such
as endianess of the target system and organization of the flash memory (for example 1 *
8 bits, 1 * 16 bits, 2 * 16 bits or 32 bits). The RAM code requires data to be programmed
into the flash memory. The data is supplied by downloading it to RAM.

8.1.2 Datadownload to RAM

The data (or part of it) is downloaded to another part of the RAM of the target system. The
Instruction pointer (PC) of the CPU is then set to the start address of the Ram code, the
CPU is started, executing the RAM code. The RAM code, which contains the programming
algorithm for the flash chip, copies the data into the flash chip. The CPU is stopped after this.
This process may have to be repeated until the entire data is programmed into the flash.

8.1.3 Available options for flash programming

In general, there are two possibilities in order to use Flasher for flash programming:

e Using Flasher stand-alone to program the target flash memory (stand-alone mode)
e Using Flasher in combination with J-Flash to program the target flash memory (Flasher
in “PC-based mode")

8.1.3.1 Using Flasher in stand-alone mode

In order to use the Flasher in stand-alone mode, it has to be configured first. For more
information about how to setup Flasher for using in “stand-alone mode”, please refer to
Setting up Flasher for stand-alone mode on page 43.

8.1.3.2 J-Flash - Complete flash programming solution

J-Flash is a stand-alone Windows application, which can read / write data files and program
the flash in almost any ARM system. For more information about J-Flash please refer to the
J-Flash User Guide, which can be downloaded from our website http://www.segger.com.

8.1.4 How does the universal flash programming work?

In universal flash programming mode, the flasher typically communicates with a boot loader
running on the device using a vendor specific protocol, rather than using the debug inter-
face.

Universal flash programming is available only for stand-alone mode.
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Glossary

This chapter describes important terms used throughout this manual.
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Big-endian

Memory organization where the least significant byte of a word is at a higher address than
the most significant byte. See Little-endian.

Cache cleaning

The process of writing dirty data in a cache to main memory.

Coprocessor

An additional processor that is used for certain operations, for example, for floating-point
math calculations, signal processing, or memory management.

Dirty data

When referring to a processor data cache, data that has been written to the cache but
has not been written to main memory is referred to as dirty data. Only write-back caches
can have dirty data because a write-through cache writes data to the cache and to main
memory simultaneously. See also cache cleaning.

Halfword

A 16-bit unit of information.

Host

A computer which provides data and other services to another computer. Especially, a
computer providing debugging services to a target being debugged.

ICache

Instruction cache.

ID

Identifier.

IEEE 1149.1

The IEEE Standard which defines TAP. Commonly (but incorrectly) referred to as JTAG.
Image

An executable file that has been loaded onto a processor for execution.

Instruction Register

When referring to a TAP controller, a register that controls the operation of the TAP.

IR

See Instruction Register.

Joint Test Action Group (JTAG)
The name of the standards group which created the IEEE 1149.1 specification.

Little-endian

Memory organization where the least significant byte of a word is at a lower address than
the most significant byte. See also Big-endian.

Memory coherency

A memory is coherent if the value read by a data read or instruction fetch is the value that
was most recently written to that location. Obtaining memory coherency is difficult when
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there are multiple possible physical locations that are involved, such as a system that has
main memory, a write buffer, and a cache.

Memory management unit (MMU)

Hardware that controls caches and access permissions to blocks of memory, and translates
virtual to physical addresses.

Memory Protection Unit (MPU)

Hardware that controls access permissions to blocks of memory. Unlike an MMU, a MPU
does not translate virtual addresses to physical addresses.

RESET

Abbreviation of System Reset. The electronic signal which causes the target system other
than the TAP controller to be reset. This signal is also known as "nSRST” “"nSYSRST”, *nRST”,
or "nRESET"” in some other manuals. See also nTRST.

NTRST

Abbreviation of TAP Reset. The electronic signal that causes the target system TAP controller
to be reset. This signal is known as nICERST in some other manuals. See also hSRST.

Open collector

A signal that may be actively driven LOW by one or more drivers, and is otherwise passively
pulled HIGH. Also known as a “wired AND" signal.

Processor Core

The part of a microprocessor that reads instructions from memory and executes them,
including the instruction fetch unit, arithmetic and logic unit, and the register bank. It
excludes optional coprocessors, caches, and the memory management unit.

Remapping

Changing the address of physical memory or devices after the application has started ex-
ecuting. This is typically done to make RAM replace ROM once the initialization has been
done.

RTOS
Real Time Operating System.

TAP Controller

Logic on a device which allows access to some or all of that device for test purposes. The
circuit functionality is defined in IEEE1149.1.

Target

The actual processor (real silicon or simulated) on which the application program is running.

TCK
The electronic clock signal which times data on the TAP data lines TMS, TDI, and TDO.

TDI

The electronic signal input to a TAP controller from the data source (upstream). Usually,
this is seen connecting the J-Link Interface Unit to the first TAP controller.

TDO

The electronic signal output from a TAP controller to the data sink (downstream). Usually,
this is seen connecting the last TAP controller to the J-Link Interface Unit.
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Test Access Port (TAP)

The port used to access a device’s TAP Controller. Comprises TCK, TMS, TDI, TDO, and
NnTRST (optional).

Transistor-transistor logic (TTL)

A type of logic design in which two bipolar transistors drive the logic output to one or
zero. LSI and VLSI logic often used TTL with HIGH logic level approaching +5V and LOW
approaching 0V.

Word

A 32-bit unit of information. Contents are taken as being an unsigned integer unless oth-
erwise stated.
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Literature and references

This chapter lists documents, which we think may be useful to gain a deeper under- standing
of technical details.
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Reference Title Comments
This document describes J-Link
i i ) . and J-Trace. It is publicly avail-
[J-Link] J-Link / J-Trace User Guide able from SEGGER (www.seg-
ger.com).

This document describes J-Flash.
[J-Flash] J-Flash User Guide It is publicly available from SEG-
GER (www.segger.com).
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